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About this document

The following topics are discussed in this section:

• “Who should read this document and why” (page 13)

• “What you need to know” (page 13)

• “How this document is organized” (page 14)

• “Text conventions” (page 14)

• “Related documents” (page 16)

Who should read this document and why
This document is for those who want to learn about the Preside Multiservice 
Data Manager (MDM) Utilities toolset. This document provides a description 
of the tools in the Utilities toolset and information on how to them.

What you need to know
This document assumes that you have basic knowledge of the following

• how to log on to a Preside Multiservice Data Manager (MDM) 
workstation

• how to use MDM 

• the UNIX operating system 

• UNIX vi text editor
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How this document is organized
241-6001-804 Preside MDM Workstation Utilities User Guide contains the 
following sections:

• “The Utilities toolset” (page 17) is a general introduction to the Preside 
Multiservice Data Manager (MDM) toolset.

• “Command Console” (page 21) explains how to use the Command 
Console utility for fault detection and correction.

• “Operational Commands GUI” (page 57) explains how to use the Java-
based MDM Operational Commands GUI to run commands and macros. 

• “Remote Access” (page 81) explains how to use the Remote Access 
utility to access a host.

• “Online Documentation” (page 89) describes the Online Documentation 
browser to view online documentation.

• “Memory Utilization tool” (page 93) explains how to use the Virtual 
Memory Utilization tool to find out how much virtual memory is 
available on your workstation.

• “Network Model Shared Memory Utilization tool” (page 97) explains 
how to use the Network Model Shared Memory Utilization tool to 
display information about the amount of shared memory available on the 
workstation for the Network Model.

• “Customer Data Tool” (page 103) explains how to use the Customer 
Data tool to access a customer data database.

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.
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• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE, lowercase

Uppercase and lowercase letters that appear in UNIX commands and 
parameters must be matched exactly. The system matches upper and 
lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).
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Related documents
See the following documents for related information:

• 241-1001-506 DPN-100 Alarm Console Indications

• 241-2001-341, NM Service Envelope Definitions

• 241-6001-011 Preside MDM Fault Management User Guide

• 241-6001-012 Preside MDM Configuration Management for DPN User 
Guide

• 241-6001-015 Preside MDM Network Model Administrator Guide

• 241-6001-101 Preside MDM Engineering Guide

• 241-6001-211 Preside MDM Embedded Programming Interface 
Reference Guide

• 241-6001-303 Preside MDM Administrator Guide

• 241-6001-304 Preside MDM Configuration Management for DPN 
Administration

• 241-6001-501 Preside MDM Alarms Reference Guide

• 241-6001-801 Preside MDM Overview

• 241-6001-802 Preside MDM User Interface Primer

• 241-6001-809 Preside MDM EPIC Reference Guide

• NN10600-500 Nortel Networks Multiservice Switch 7400/15000/20000 
Alarms Reference
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Chapter 1
The Utilities toolset

The Utilities toolset is a set of Preside Multiservice Data Manager (MDM) 
utilities. This chapter contains the following:

• “MDM Utilities” (page 17)

MDM Utilities
Preside Multiservice Data Manager (MDM) Utilities are productivity tools 
that include:

• UNIX Access creates a window that runs a UNIX shell.

Note: The UNIX Access utility is not provided by MDM. It is a standard 
application delivered with the Solaris operating system to which the 
Utilities toolset provides access.

• EPIC is an interactive command line interface that simplifies network 
element surveillance and provisioning

— see the 241-6001-809 Preside MDM EPIC Reference Guide

• Remote Access lets you access a host from a remote location.

— see “Remote Access” (page 81)

• Command Console allows you to directly access the switching element 
and its corresponding command set.

— see “Command Console” (page 21).

• Memory Utilization displays information about the amount of virtual 
memory available on the workstation.
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— see “Memory Utilization tool” (page 93)

• Network Model Shared Memory Utilization displays information about 
the amount of shared memory available on the workstation for the 
network model.

— see “Network Model Shared Memory Utilization tool” (page 97)

• the MIB Browser utility lets you browse MIBs and perform other related 
functions

— see “MIB Browser” (page 18)

• Customer Data provides access to the customer data database and allows 
you to add, change, query, delete, and view customer information.

— see “Customer Data Tool” (page 103)

• The online documentation and help facility provides access to the 
complete set of MDM online documents.

— see “Online Documentation” (page 89)

MIB Browser
The MIB Browser is provided as a general utility and is supported by the 
Preside Multiservice Data Manager (MDM) using the AdventNet Web NMS 
software. 

The MDM performance management tool Data Viewer uses the AdventNet 
Web NMS toolkit. The MIB Browser part of that toolkit has been integrated 
into MDM. Use the MIB Browser to load and view multiple MIB modules, 
traverse the MIB tree to look at the definitions, and view and operate on data 
available through an SNMP agent on a network managed device.

For additional information on the MIB Browser, use the MIB Browser’s Help 
menu or refer to the AdventNet web site at 
http://www.adventnet.com.

Starting the MIB Browser
1 In the application main window, select System -> Utilities -> MIB Browser.

The MIB Browser opens.
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Saving loaded MIB files
If you do not save the loaded MIB files, all of the loaded files will be lost 
when the browser is restarted and you will have to load them again.

Procedure steps
1 Copy the file /opt/MagellanNMS/lib/cfg/loadmib.cfg to 

/opt/MagellanNMS/cfg.

2 Add MIB files, in order, to /opt/MagellanNMS/cfg/loadmib.cfg. Some 
common MIB files can be found in 
/opt/MagellanContrib/Advent/current/builder/mibs.

XFile
XFile is a standalone tool that is used by applications in Preside Multiservice 
Data Manager (MDM) as a general utility for viewing files. For example, 
both Alarm Display and DPN Performance Viewer use this utility as their log 
file viewer.

The XFile window has the following components: 

• The File Name text field. You use this field to enter the name of the file 
that you want to view.

• A scrollable area in which the file contents are displayed.

• The Show button that refreshes the contents of the display area with the 
current content of the specified alarm file.

• The Pause/Resume button that lets you pause the display of incoming 
alarms. When the display has been paused, a red border surrounds the 
alarm information and the label on the button changes to Resume. 
Clicking the Resume button removes the red border and resumes the 
display the incoming alarms.

• The Close button that closes the window.
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Chapter 2
Command Console

Command Console is an operator command application that lets you directly 
access network nodes and their corresponding command sets.

Note: In the Operator Client environment, a connection to a group 
established through either Command Console or Operational Commands 
(using the Connection Management application), or Passport Shelf View 
is shared among all of these applications. As a result, terminating a 
connection by selecting "Disconnect" from Connection Management 
impacts all of the connections. Any of the above applications that are 
using the group connection will also be disconnected. Passport supports 
a maximum of 35 FMIP sessions per node. This sharing of connections 
by multiple tools for a single user session is necessary to minimize the 
consumption of FMIP sessions on-switch.

Navigation
• “Command Console procedures” (page 22)

• “Operator Commands procedures” (page 26)

• “Prefix Editor procedures” (page 28)

• “Command Console interface in MDM Toolset” (page 31)

• “Command Console menu bar in MDM Toolset” (page 32)

• “Command Console interface in MDM Operator Client” (page 34)

• “Command Console menu bar in MDM Operator Client” (page 35)

• “Command Console response area” (page 37)
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• “Command Console command area” (page 37)

• “Command Console dialogs” (page 41)

• “Command Console fundamentals” (page 44)

• “Operator Commands fundamentals” (page 52)

• “Prefix fundamentals” (page 54)

Command Console procedures
Starting and exiting the Command Console

• “Starting the Command Console” (page 22)

• “Exiting the Command Console” (page 22)

Managing connections

• “Connecting to the network” (page 23)

• “Setting the current connection in MDM Toolset” (page 24)

• “Disconnecting from the network” (page 24)

Setting up command routing

• “Setting up command routing” (page 24)

Enabling and disabling logging

• “Enabling command response logging” (page 25)

• “Disabling command response logging” (page 26)

Starting the Command Console 
1 In the Preside Multiservice Data Manager window, select System, 

Utilities and then Command Console.

The Command Console window opens.

Exiting the Command Console
1 From the Command Console window, click File and then Exit.

The Command Console window closes.
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Connecting to the network
Use the following procedure to establish a connection to a network 
destination.

1 From the Command Console window, click Security and then 
Connection Management. 

The Connection Management dialog opens. The host to which the 
Connection Manager is currently connected is displayed at the top of the 
dialog followed by the Network Destination List just below it. You can use 
the Show Groups and Show Dest Mnem buttons to determine the 
contents of the Destination List. 

The Show Groups button can include or exclude groups or OA’s.

2 From the System menu, click Administration and then Service 
Selection-User Specific to start the Service Selection tool.

The Service Selection-User Specific dialog opens.

3 From the Service Selection-User Specific dialog, make any required 
changes to the current network access service selections. 

As you make changes in the Service Selection tool, the connection dialog 
updates to show the available destinations on that server. When you 
perform a service selection, your existing connections are retained 
(whatever server they were actually established against).

4 From the Connection Management dialog, enter a destination in the 
Destination field. Alternatively, double-click an entry in the Destination list.

5 Type your user ID and password in the appropriate fields. Alternatively, 
double-click an entry in the User ID field.

You must fill in these text fields before you can connect to the network.

Note:  If you have already successfully entered a user ID and password 
during the current login session, choosing a user ID from the User Id list 
pastes this information in these fields. 

6 Click Connect.

When the connection is successful, the Connection Management dialog 
remains open so you can make other connections. 

7 Click Close. 

The Connection Management dialog closes. You can now issue 
commands to the destination address. After a successful connection, the 
Route field in the Command Console changes to this connection. All 
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subsequent commands in the Command Console are directed to that 
route. The message area displays any messages pertinent to this 
connection.

Setting the current connection in MDM Toolset
Use the following procedure to determine which network connections are 
currently available.

1 From the Command Console window, click Options and then Current 
Connections…. 

The Current Connections Dialog opens. A list of active components and 
the host used to establish the connection are displayed in the dialog. 

2 To set your current route to one of the routes in the list, click the desired 
route name and then click Set Route.

The route indicator in the main Command Console window displays the 
new route and host used in establishing the connection.

Disconnecting from the network
Use the following procedure to disconnect an existing network connection.

1 From the Command Console window, click Security and then 
Connection Management.

The Connection Management dialog opens.

2 Select the destination to disconnect from the Destination list. 

3 Click Disconnect. 

4 To close the Connection Management dialog and return to the Command 
Console, click Close.

The Connection Management dialog closes and the Command Console 
main window opens. The message area displays any messages pertinent 
to this disconnection.

Setting up command routing
A command route specifies the destination for a command entered in the 
command entry area. The default is a dollar sign ($), which directs the 
command to UNIX on the workstation. Use the following procedure to set the 
current route. 
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1 In the Command Console window, click the downward pointing arrow on 
the right side of the Route box.

A list box opens and displays the list of available routes.

2 Click an entry from the list of available routes.

The name of the selected route is displayed in the Route field.

You can change the current route shown on the Route field by performing one 
of the following actions:

• entering a new route name as a command. Entering the dollar sign ($) 
command sets the route back to the UNIX system. 

• entering a new route name followed by a command to execute the 
command and change the default route to the new route name 

• double-clicking on a route from the list of routes in the Current 
Connections Dialog 

In each of these cases, you need to enter a route that is connected through the 
Connection Manager. The only exception to this is route $, the UNIX system, 
which is available by default. The current prefix is also cleared (that is, set to 
none) in each case. 

Enabling command response logging
Use the following procedure to specify a log file that automatically collects 
all command responses.

1 From the Command Console window, click File and then Log to file….

The Log to file dialog opens. 

2 Specify the directory and file where the logs are to be stored by selecting 
the appropriate entries in the Directories and Files lists. If necessary, 
click Change Directory to change the listing of directories. Alternatively, 
you can type the pathname in the Selection field. 

3 If a log file currently exists and you want to overwrite it with the new 
responses, enable the Overwrite if existing? button. 

4 To activate the log to file process,
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Disabling command response logging
1 From the Command Console window,

Logging to file is immediately terminated.

Operator Commands procedures
• “Starting the Operator Commands tool” (page 26)

• “Executing an alternate command” (page 27)

Starting the Operator Commands tool
1 From the supporting tool (Network Viewer, Component Information 

Viewer, or Alarm Display), select the component to which you want to 
make a network connection. 

2 From the Start Tool submenu, click Utilities and then Operator 
Commands. 

The Operator Commands tool opens with a choice of command 
selections.

Note:  The command selections vary depending on the type of 
component you choose.

3 Select the number or letter corresponding to the command you want 
issued. 

4 Press the Return key.

if running... click...

MDM Toolset Start Logging.

MDM Operator Client Open.

if running... click...

MDM Toolset File and then Stop file logging

MDM Operator Client the check mark beside Log to File to 
remove the check mark.
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If a network connection exists for the appropriate node, the connection is 
used to execute the command. If a network connection does not exist, you 
are prompted for authentication information: Destination, Capability ID 
and Password. 

5 After the command execution is complete, to display the command menu, 
press the Return key. 

6 To exit the Operator Commands tool, select q.

The Operator Commands tool closes.

Executing an alternate command
Note: To enter a command that is not available in the current menu list, 
use the o and O options. 

1 From the supporting tool, select the module to which you want to make a 
network connection. 

2 On the Start Tool submenu, choose Operator Commands. 

The Operator Commands tool opens with the choice of command 
selections.

3 Enter either o for Other Command on Component or O for Other 
Command on Destination.

The tool prompts you to manually enter commands for the current 
component or for the OA/Group destination. 

4 Enter the command on the prompt line and press the Return key.

If a network connection does not exist, you are prompted for 
authentication information: Destination, Capability ID and Password. If a 
network connection exists for the appropriate node, the connection is 
used to execute the command. 

5 After the command is executed, press the Return key and manually enter 
a new command. 

6 Press the Return key (empty line) to return to the main menu. 

7 To quit the Operator Commands tool, select q.

The window closes.

Note:   You can quit the window at any time: type Ctrl-C to cancel the 
operation then press the Return key to exit the window.
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Prefix Editor procedures
Starting and exiting the Prefix Editor 

• “Starting the Prefix Editor” (page 28)

• “Exiting the Prefix Editor” (page 28)

Creating, Saving, and Deleting command prefixes

• “Creating command prefixes” (page 29) 

• “Saving command prefixes to a file” (page 29)

• “Deleting a command prefix” (page 29)

Activating and Deactivating a pre-defined command prefix

• “Activating a pre-defined command prefix from the Command Console 
window” (page 30)

• “Activating a pre-defined command prefix from the Prefix Editor” 
(page 30)

• “Deactivating a pre-defined command prefix from the Prefix Editor” 
(page 30)

Managing automatic prefixes

• “Setting automatic prefix mode” (page 30)

• “Controlling automatic prefixes” (page 31)

Starting the Prefix Editor
1 From the Command Console window, click Options and then Prefix 

Editor.

The Prefix Editor dialog opens.

Exiting the Prefix Editor
1 From the Prefix Editor dialog, click Close.

The Prefix Editor dialog closes.
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Creating command prefixes
Use the following procedure to create a prefix from the Prefix Editor Dialog. 
For a description of the dialog, see “Prefix Editor dialog” (page 43).

1 From the Prefix Editor dialog, type the desired text in the Edit prefix field. 

You can specify a number for the prefix by typing a number, a space, and 
then the desired text. 

If you specify a number for the prefix and a prefix currently exists with this 
number, it is overwritten with the new prefix text. The new prefix is 
automatically activated and becomes the current prefix. For a prefix that 
begins with a number, you need to specify both the number of the prefix 
and the prefix; otherwise, the Command Console takes the leading 
number of the prefix and uses it as the index for the prefix.

2 Click Add.

The text is added to the prefix list. If you specify a number, the prefix is 
added in the specified order. If you do not specify a number, the prefix is 
placed at the end of the list and is given the next available number.

Saving command prefixes to a file
Use the following procedure to save prefixes to a file, making them available 
for subsequent Command Console sessions.

1 From the Prefix Editor dialog, click Save Prefix List.

The prefixes are saved and are available the next time you start the 
Command Console.

This button is available only when a modification is made to the prefix list. 
Modifications include the addition of a new prefix, a change to an existing 
prefix, and the deletion of a prefix.

Deleting a command prefix
Use the following procedure to delete a defined prefix from the Prefix Editor 
dialog.

1 From the Prefix Editor dialog Prefix list, click on the prefix you want to 
delete. 

2 Click Delete.

The selected prefix is deleted from the list.
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Activating a pre-defined command prefix from the Command 
Console window

Use the following procedure to activate a command prefix.

1 From the Command Console window, click the downward pointing 
arrow to the right of the Prefix box. 

A list of available prefixes is displayed. 

2 From the list of prefixes, click the desired prefix.

The selected prefix is displayed in the Prefix field.

Activating a pre-defined command prefix from the Prefix 
Editor

Use the following procedure to activate a command prefix.

1 From the Prefix Editor dialog, click an entry in the Prefix list.

2 Click Activate.

The selected prefix appears in the Prefix field.

Note:  This prefix continues to be used until it is deactivated, until another 
prefix is selected or added, or until the Route is changed. You can also 
double click on a prefix in the list to activate it. When a prefix is added it 
becomes the current prefix.

Deactivating a pre-defined command prefix from the Prefix 
Editor

Use the following procedure to deactivate a command prefix.

1 From the Prefix Editor dialog, click an entry in the Prefix list

2 Click Deactivate.

The current prefix is deactivated and removed from the command entry 
area of the main window. The value in the command defaults area is set 
to none.

Setting automatic prefix mode
Use the following procedure to turn automatic prefix mode on or off. For 
more information, see “Automatic prefix mode” (page 54)

1 From the Command Console window, perform one of the following tasks:
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a. On the Options menu, click Set Auto-Prefix On. 

b. On the keyboard press Ctrl+A.

Automatic prefix mode is enabled and the menu command changes to Set 
Auto-Prefix Off. When the Auto-Prefix command is enabled, typed 
commands are converted to prefix for the next command. 

Choose Set Auto-Prefix Off, or press Ctrl+A again to disable automatic prefix 
mode. The content of the command entry area is cleared and replaced by the 
current default prefix, if any.

Use the following procedure to convert a previous command into a prefix. For 
more information, see “Setting automatic prefixes” (page 56)

Controlling automatic prefixes
1 From the Command Console window, click a previous command from the 

command history area. If no selection is made, the last issued command 
will be used. 

2 On the Options menu, click Recall History as Prefix. Alternatively, you 
can press Ctrl+H.

The selected, or last, command is converted to prefix for the next 
command.

Command Console interface in MDM Toolset
Preside Multiservice Data Manager (MDM) provides the Command Console 
utility for fault detection and correction. The Command Console is a utility 
under the System toolset in the MDM main window.

The Command Console main window consists of the following areas:

• “Command Console menu bar in MDM Toolset” (page 32)

• “Command Console response area” (page 37) 

• “Command Console command area” (page 37) 

See the figure “Command Console main window in MDM Toolset” (page 32) 
for a sample Command Console main window.
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Figure 1
Command Console main window in MDM Toolset

Command Console menu bar in MDM Toolset
The Command Console menu bar consists of the following menus:

• “File menu” (page 33) 

• “Options menu” (page 33) 

• “Security menu” (page 34) 

• “Help Menu” (page 34) 

menu bar

command 
response 
area

command 
area

command historycommand defaultscommand entry
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File menu
The File menu provides the following commands:

Options menu
The Options menu provides the following commands:

Command Description

Log to file… opens the Log to File Dialog allowing you to 
specify the file to use for logging all subsequent 
command output. This command is available 
only when logging to a file is disabled.

Stop file logging stops command output from being logged to a 
file. This command is available only logged to a 
file is enabled.

Exit ends the Command Console session

Command Description

Prefix Editor… displays the Prefix Editor dialog. For details on 
the dialog, see “Prefix Editor dialog” (page 43)

Current Connections… displays the Current Connections Dialog. For 
details on the dialog, see “Current Connections 
dialog” (page 42)

Set Auto-Prefix On enables automatic prefix mode. This command is 
available only when automatic prefix mode is 
disabled. For details, see “Automatic prefix 
mode” (page 54).

Set Auto-Prefix Off disables automatic prefix mode. This command 
is available only when automatic prefix mode is 
enabled. For details, see “Automatic prefix 
mode” (page 54).

Recall History as Prefix recalls the selected command history entry or the 
last executed command as a command prefix for 
the next command. For details, see “Automatic 
prefix mode” (page 54)
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Security menu
The Security menu provides the following command:

Help Menu
The Help menu provides the following commands: 

Command Console interface in MDM Operator Client
Preside Multiservice Data Manager (MDM) provides the Command Console 
utility for fault detection and correction. The Command Console is a utility 
under the System toolset in the MDM main window.

The Command Console main window consists of the following areas:

• “Command Console menu bar in MDM Operator Client” (page 35)

• “Command Console response area” (page 37) 

• “Command Console command area” (page 37) 

See the figure “Command Console main window in MDM Operator Client” 
(page 35) for a sample Command Console main window.

Command Description

Connection 
Management… 

displays the Connection Management Dialog 
allowing you to make and remove connections to 
network destinations. For details, see 
“Connection Management dialog” (page 41).

Command Description

Help on Window Provides help on the Network Browser window.

Help on Context Provides help on certain parts of the window.
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Figure 2
Command Console main window in MDM Operator Client

Command Console menu bar in MDM Operator Client
The Command Console menu bar consists of the following menus:

• “File menu” (page 33) 

• “Options menu” (page 33) 

• “Security menu” (page 34) 

• “Help Menu” (page 34) 

File menu
The File menu provides the following commands:

menu bar

Command 
Console 
response 
area

command 
history
area

Command 
entry area
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Edit menu
The Edit menu provides the following command:

Security menu
The Security menu provides the following command:

Help menu
The Help menu provides the following commands: 

Command Description

Save output as... saves the output file as a text file.

Prefix Editor... displays the Prefix Editor dialog. For details on 
the dialog, see “Prefix Editor dialog” (page 43)

Log to file... saves the log session as a text file.

Print prints the log session.

Exit ends the Command Console session

Command Description

Copy copies text

Command Description

Connection 
Management… 

displays the Connection Management Dialog 
allowing you to make and remove connections to 
network destinations. For details, see 
“Connection Management dialog” (page 41).
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Command Console response area
The command response area displays both the operator command and the 
response to the command. Each command in the command response area has 
an associated sequence number for easy reference. 

Commands in the command response area are displayed in full, that is, the 
command is shown with any command route and prefix in effect. For 
example, if you set Route to NODER16_GRP and Prefix to noder16, then 
enter the command d lp/0, the command is displayed in the command 
response area as #1 : NODER16_GRP noder16 d lp/0. 

If a response to a command is interspersed with responses from other 
commands, the command text is followed by the string …continued…. The 
end of the response for any command is indicated by a line that contains the 
command number and the string Request Completed. 

To save the contents of the command response area, use one of the following 
methods:

• enable Log to file… which also saves the command response area

• cut and paste to extract portions of the response text

• use drag and drop techniques to select portions of text to drop onto the 
printer icon in the common desktop environment (CDE) Front Panel 

Command Console command area
The command area is made up of three smaller areas which include the 
following:

• “Command history area” (page 38) 

• “Command defaults area” (page 39) 

• “Command entry area” (page 39) 

Command Description

Help on Window Provides help on the Network Browser window.

What’s This? Provides help on certain parts of the window.
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Command history area
The command history area displays a list of all the commands you entered in 
the command entry area. All commands except for connect and disconnect 
are added to the command history. Each entry has a sequence number to 
associate a command with its response. In addition to commands, the 
following character indicators can also appear in the command history area: 

• (…) to indicate a command is executing

• (ok) to indicate successful completion of a command

• (X) to indicate completion of a command but with errors

Use the command history area to re-execute a previous command. The 
following methods are available:

• Double-click, using the mouse select button, on a command in the 
command history. 

• Select a command in the command history. To do so, click, using the 
mouse select button, on a command. The command is automatically 
pasted in the command entry area. If needed, you can edit the command; 
otherwise, execute the command by pressing the Return key. 

• Select a command from the command history by clicking on a command 
using the mouse select button. From the Options menu, choose Recall 
History as Prefix. The selected command is pasted into the command 
entry area as a prefix. Type the command verb and press the Return key.

The command history area provides additional functionality through its 
pop-up menu. To display the command history pop-up menu, click on a 
command in the command history using the mouse menu button. The 
command history pop-up menu opens providing the following commands:

• Cancel stops the command that is currently executing. Currently 
executing commands are shown with the indicator (…). You can cancel 
only DPN and UNIX commands.

• Show Response finds the command in the command response area and 
highlights the beginning of the response. If the response is interspersed 
with other commands, you can issue subsequent Show Response 
commands on the same history item to show the remaining output. 
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Command defaults area
The command defaults area contains two boxes that display the current 
command route and any active prefix. The boxes and their functions are as 
follows:

• Route: lets you define a destination for a command. This destination is 
known as the command route. To access available routes, click the 
downward pointing arrow on the right side of the Route box. The list of 
available routes includes any group to which you are currently connected 
and three specialized routes. For instructions on how to set a command 
route, see “Setting up command routing” (page 24). The specialized 
routes consist of the following:

— $ (UNIX macro route): lets you direct a command to the UNIX 
workstation and is the default route 

— @ (SNMP command route): lets you perform Simple Network 
Management Protocol commands 

— * (wild-card route): lets you direct commands to nodes in any of the 
connected groups without having to know to which group the node 
belongs 

— The Command Console automatically routes the command to the 
appropriate group. 

• Prefix: lets you add a prefix to a command. A prefix is a command string 
that is added automatically to the beginning of any command you enter 
in the command entry area. You can select a prefix from a list of available 
prefixes; or, you can use the automatic prefix option. For more 
information on prefixes, see “Prefix fundamentals” (page 54). For 
instructions on how to set command prefixes, see “Prefix Editor 
procedures” (page 28)

Command entry area
Use the command entry area to enter commands. You can perform the 
following functions using the command entry area: 

• enter a command

• edit an existing command displayed in the command entry area

• recall the last command by entering an equal sign (=)
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• paste a command copied from the command response area

• automatically paste commands by clicking on a command in the 
command history area

• create a prefix using the command

• .PREF DEF <prefix_value> 

• create or replace a prefix using the command

• .PREF <pref_num> DEF <prefix_value>

• delete a prefix using the command

• .PREF <pref_num> UNDEF

If you set a Prefix command default, this default is added automatically to the 
command entry area. For example, if you set Prefix to R72, then the string 
R72 is automatically pasted into the command entry area. Each command that 
you type in the command entry area will have the prefix R72 appended to it. 

You can temporarily override a prefix using the command entry area. Any 
changes you make to a prefix in the command entry area apply only to the 
next command you execute. For example, assume you have set Route to 
CORENCS and Prefix to R72 but you want to execute the display command 
with a prefix of R7 on the next command. The existing default R72 is 
automatically pasted into the command entry area. To change this prefix, 
delete 2 from the prefix R72 in the command area and then type display. The 
command CORENCS R7 DISPLAY is executed. The ability to modify a 
prefix in the command entry area is useful when working with large prefixes.

You can change the default route setting using the command entry area. To do 
so, type another route as the first token in the command entry area. Providing 
a route as the first token also deactivates the current prefix setting because 
prefixes are usually route-specific. For example, if you have set Route to 
CORENCS and Prefix to R72 and then enter TOPNCS dir in the command 
entry area, the route changes to TOPNCS, the prefix changes to none, and the 
command TOPNCS dir executes.

The command entry area has a pop-up menu that contains the command Get 
Context. This command allows you to paste the current component from 
context into the command area. 
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Command Console dialogs
The Command Console provides the following dialogs:

• “Connection Management dialog” (page 41) 

• “Current Connections dialog” (page 42)

• “Prefix Editor dialog” (page 43)

• “Log to File Dialog” (page 44)

• “Bad Log File Error Dialog” (page 44)

Connection Management dialog
The Connection Management dialog lets you to log on to a network 
destination. This dialog provides the following options: 

• Server Host displays the server host name. All network communications 
are performed through this host. 

• Destination List lists all the destination nodes which are available from 
the current server host. Available nodes are identified by either a 
mnemonic or a GROUP name. Selecting an item from the destination 
list, populates the Destination and User Id fields. 

• In MDM Toolset, Double click on the Destination list to select the 
destination and perform the default action (you must first supply a user 
id and password). The state is "CONNECTED" if any active connections 
exist to the destination. The state is "AUTHENTICATED" if any 
authentication data is available for the destination. 

• Destination Buttons let you to hide/show the destinations. 

• Service Selection... opens the Connection Service Selection dialog of the 
Service Selection tool. This dialog lets you select a different service host 
from the network access selection areas. Opened in this way, the Service 
Selection tool applies changes to a single user session only; it does not 
apply changes to other users of the same workstation. This lets you 
rapidly connect to different groups and OAs supported by different 
Preside Multiservice Data Manager servers. For details on the tool, see 
the 241-6001-303 Preside MDM Administrator Guide. 
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• User Id List displays all previously authenticated user IDs associated 
with the selected destination and allows you to re-use authentication 
data. 

• Destination lets you type a destination into this field rather than selecting 
one from the Destination list. 

• User Id lets you type a user ID into this field rather than selecting one 
from the User Id List. 

• Password lets you to type a Password into this field if the field has not 
already been populated. 

• Message displays messages related to the current authentication request. 

• Connect performs authentication. The Messages field displays the status 
of the authentication request. The dialog remains open upon successful 
completion to allow you to make other connections. 

• Disconnect terminates the connection to the network destination. 

• Close closes the dialog and returns to the Command Console. 

The Connection Management dialog appears automatically the first time you 
start the Command Console and there is no current group or operations agent 
(OA) connection.

Current Connections dialog
The Current Connections dialog lets you view all the currently available 
connections and select a new route.

The dialog contains a connection list with the following information for each 
connection: 

• Route is the name of the operations agent (OA) or group that is 
connected. 

• Type is one of the following connection types:

— MACRO (UNIX macro route $)

— SNMP (SNMP command route @)

— ALL GROUPS (wild-card route *)

— GROUP
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— DEST MNEM (destination mnemonic)

Via Host is the host name of the workstation that is used for establishing the 
connection.

The dialog also contains the following buttons:

• Set Route sets the current route to the selected route. It is operable only 
when a selected item in the connection list is available.

• Close exits the Current Connections Dialog.

• Help displays information on the Current Connections Dialog

Prefix Editor dialog
The Prefix Editor dialog lets you enter or modify a set of prefixes as follows: 

• Prefix List provides a sequential list of available prefixes. You can 
activate a prefix by double-clicking an entry in the Prefix List.

• Edit Prefix enables you to edit a single entry. To enter a prefix to edit, 
click an item in the Prefix List.

The dialog contains the following buttons:

• Add adds a new or changed value in the selection area to the list. If the 
selection is numbered, it replaces or inserts the prefix in the list. If the 
selection is not numbered, it is added to the end of the list with the next 
valid prefix number. This button is available after you enter a new prefix 
or modify an existing prefix.

• Delete deletes a selection from the list. This button is available only 
when you select an entry from the Prefix List.

• Activate makes the selected prefix the current prefix and gives the 
current prefix special status in the command entry area of the main 
window. This button is available after you select an entry prefix from the 
Prefix List. 

• Deactivate removes the selected prefix from its special status in 
command line initialization. This button is available after you have 
activated a prefix. 
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• Save Prefix List saves the prefix list and is available when at least one 
prefix has added, modified, or deleted.

• Close closes the Prefix Editor dialog.

• Help displays information on the Prefix Editor dialog.

Log to File Dialog
The Log to File Dialog lets you specify the file for logged command output.

This dialog is a standard Motif File Selection dialog with an additional 
Overwrite if existing? toggle button. The dialog controls are as follows:

• Overwrite if existing? discards the contents of an existing file when 
logging starts.

• Start Logging closes the dialog and begins logging command output to 
the file identified in the Selection field.

• Cancel closes the dialog without logging.

• Change Directory changes the pathname in the Selection field to the 
directory selected in the Directories list.

• Help displays information on the Log to File Dialog.

If the selected file cannot be opened for logging, an error dialog will be 
displayed and a new file can be selected.

Bad Log File Error Dialog
If you select a file from the Log to File Dialog than cannot open for output, 
then the Bad Log File Error Dialog is displayed. The file or the directory may 
have incorrect access privileges. To continue, close the dialog, fix the 
problem, and select either the same log file or a different log file.

Command Console fundamentals
The Command Console is an operator command application that allows you 
to directly access the switching node and its corresponding command set. 

The Command Console provides the following functionality: 

• an interactive operator command interface for network control

• the ability to issue operator commands directly to a switching element
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• a DPN network control system (NCS) command interface 

• a Passport command interface 

• the ability to use UNIX commands and Simple Network Management 
Protocol (SNMP) commands

• multiple simultaneous connections to NCS operation agents (OAs) and 
operator interfaces

• simple text entry for commands and delivery of whole command lines to 
remote systems

• command prefixing and command routing

• automatic prefixing which converts the previously issued command into 
a properly structured prefix for the next command

• the ability to log command and command output to a file

To use the Command Console, you need to be familiar with operator 
commands described in the following documents:

• 241-6001-303 Preside MDM Administrator Guide

• 241-1001-303 DPN-100 Operator Commands and Responses

• NN10600-050 Nortel Networks Multiservice Switch 7400/15000/20000 
Command Reference

• 241-2001-351 DPN-100 Network Control System Operations and 
Maintenance.

Establishing a network connection
The Command Console establishes communications with nodes through the 
Connection Manager. The actual connection process is transparent. After you 
select a destination and type your user ID and password in the Connection 
Manager Dialog, a network connection is requested.

Note: Your Preside Multiservice Data Manager system administrator 
may have configured your workstation to open the Command Console 
automatically when you log on. 
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Sharing connections
You can run multiple Command Console sessions on your workstation. If you 
do, each session has access to connections that any other Command Console 
session makes. Also, each session is informed when a connection is 
established.

Dealing with connection failures
Connection failures result in the cancellation of all outstanding commands 
that are running against the failed connection. If the current route is the same 
as the connection that fails, the current route is set to $. You may have to find 
the source of the problem and correct it, or you may have to reconnect. 

Entering commands
When you enter a command, the first stage of command processing is a scan 
for prefix substitution. If a prefix is present in the line, substitution is 
performed; the current prefix is set as the prefix used in the command. The 
next stage is the assignment of a command route to the command. For 
information about command routes, see “Setting up command routing” 
(page 24).

Note: To ensure that commands are executed in operational mode (not 
provisioning mode), use the -o or -c options with each command you 
enter. Alternatively, check that you are already in operational mode by 
entering the ME command. The syntax is: <nodename> ME.

The command is then sent for execution. If no prefix is used, the command 
line is directly sent directly for execution. For information about prefixes, see 
“Prefix Editor procedures” (page 28).

The command is then assigned a sequence number and copied to both the 
response area and history list. It is displayed in the command history area 
using a (…) indicator until it is complete. If it completes successfully (or with 
no error return code), the indicator is changed to (ok). If it completes 
unsuccessfully, the indicator is changed to (X). Results of command 
execution are displayed in the command response area as they are received. 

You can send the following classes of commands from the Command 
Console.
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Network control system (NCS) commands These are described in the 
following publications:

• 241-1001-301, Network Module Operator Commands and Responses 

• 241-1001-303 DPN-100 Operator Commands and Responses 

• 241-2001-350, NCS Operations and Maintenance 

You need to be logged on to an OA to issue NCS commands and view the 
responses. 

Group commands These are described in NN10600-050 Nortel Networks 
Multiservice Switch 7400/15000/20000 Command Reference. You need to be 
logged on to a GROUP to issue these commands and view the responses.

Hold command To stop an NCS command from timing out, type the 
command hold in the command entry area before the NCS command. For 
example

hold N12 test 9 48 card 5

Command prefixes Command prefixes are text command strings that you 
place before any command in the input area. The Command Console lets you 
create, store, and use up to 60 different command prefixes. For detailed 
information about prefixes see “Prefix Editor procedures” (page 28).

UNIX commands (macros) You can type UNIX commands from the 
Command Console by prefixing $ to the command. For example, to get a list 
of files in the UNIX working directory, type the following command:

$ls -1

You can find UNIX commands in UNIX handbooks. The Preside 
Multiservice Data Manager (MDM) documentation describe only the 
commands needed to run the MDM software.

Disruptive Commands
The Disruptive Command Safeguard facility needs to be installed by the 
MDM system administrator. The Disruptive Command Safeguard searches 
command strings that you enter for any keywords that are considered 
disruptive. See 241-6001-303 Preside MDM Administrator Guide, for 
instructions on configuring the Disruptive Command Safeguard facility.
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If you have the capability to execute a command that might be disruptive, a 
prompt is displayed when you enter one. If you do not have this capability, 
the command is rejected and no message is issued. 

Disruptive keywords 
The following keywords are considered disruptive by default. Contact your 
system administrator for other keywords that may be added to the following 
list.

• ACTIVATE 

• COMMIT 

• CONFIRM 

• DEREGISTER 

• DISABLE 

• ERASE 

• FILTER 

• FORMAT 

• LOAD (see note below) 

• REFUSE 

• REGISTER 

• RELOAD 

• RESET 

• RESTART 

• STOP 

Note: If any of these keywords are preceded by the keyword Query or 
Display, the keyword is not considered disruptive. For example, Display 
Committed and Query Load are not disruptive; however, Load and 
Committed are disruptive.
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Creation, modification, and deletion of prefixes from the 
command entry area

The syntax used to change the command prefix in the command entry area of 
the Command Console window is as follows:

PREF <pref_num> DEF <pref_value>

This command adds or replaces a prefix whose prefix number is <pref_num> 
with value <pref_value>. 

PREF DEF <pref_value>

This command adds the prefix <pref_value> to the next sequential location in 
the prefix list. 

PREF <pref_num> UNDEF

This command deletes the prefix whose prefix number is <pref_num> from 
the prefix list. 

You can invoke prefixes by entering <prefix-num> as the first token in the 
command entry area. The prefix system supports the use of routing IDs within 
prefix definitions. 

The special prefix value (.) is used to deselect the current prefix and return a 
null initial value to the command line. Additionally, if you type only a prefix 
in the command entry area, it changes only the current prefix. 

When a prefix value is encountered in the first token of a command line, the 
system completes prefix substitution and resets the current prefix to the 
substituted value. 

When a line is submitted that does not use any prefix, that line is passed to the 
routing system for transmission to the appropriate managed device. 

Examples:
Suppose the following conditions exist:

• You have a prefix list consisting of

— 1. R72

— 2. N12
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• Connections CORENCS and TOPNCS are available, where TOPNCS is 
the current route.

Typing:

• 2 sets the current prefix to N12.

• .2 DIR executes the command TOPNCS N12 DIR.

• CORENCS .1 DIR changes the current prefix to R72, changes the current 
route to CORENCS, and executes the command CORENCS R72 DIR. 

• . (a period) sets the current prefix to none.

To save prefixes for use in subsequent Command Console sessions, click 
Save Prefix List in the Prefix Editor dialog. 

Keyboard shortcuts
The Command Console provides the following command shortcuts:

• Ctrl+E closes the Command Console. 

• Ctrl+P opens the Prefix Editor dialog. 

• Ctrl+C opens the Connection Management dialog. 

• Ctrl+A sets automatic prefix on or off 

• Ctrl+H converts a previous command into a prefix for the next command

Command Console customization
You can customize the Command Console to 

• ensure that the Connection Management dialog opens automatically 
when you open the Command Console 

• prevent the execution of UNIX commands from the Command Console 

• initiate the log-to-file feature when the Command Console starts

To customize an installation, you need to change the application default file 
for the Command Console. The default file is /opt/MagellanNMS/lib/
app-defaults/<lang>/CMC directory, where <lang> is one of: C (English), ja 
(Japanese), or zh (Chinese). Changes to this file affect all users of that 
installation.
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Note: Specifications made in a user’s .Xdefaults file override any 
corresponding specifications in application default files.

To customize a single user, you need to change the user’s .Xdefaults file in 
the user’s home directory. For example, the user oper1 can edit the file /home/
oper1/.Xdefaults/<lang> where <lang> is one of C (English), ja (Japanese), 
or zh (Chinese). Changes to this file affect a single user only and are usually 
put into effect when the user logs in to the account. Changes to the.Xdefaults 
file can be made effective immediately by executing the following command 
from a UNIX access window:

/usr/openwin/bin/xrdb -merge .Xdefaults

The table “Resources for customizing the Command Console” (page 51) lists 
the resources you use to customize the Command Console. 

Table 1Resources for customizing the Command Console

Resource Description Legal values

CMC*pop-upCM If the value is set to True, the 
Connection Manager window 
automatically opens when you 
start the Command Console. If 
the value is set to False, the 
Connection Manager window 
does not open automatically. 

The default value is False.

True or False

CMC*unixAccess If the value is set to True, UNIX 
commands are executed. If the 
value is set to False, UNIX 
commands are prevented from 
executing. 

The default value is True.

True or False

 (Sheet 1 of 2)
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Operator Commands fundamentals
You can enter selected operator commands from anywhere a component can 
be selected and from within tools that support a Start Tool submenu; namely, 
the network viewer, the component information viewer and the alarm display.

The Operator Commands tool is supported for: 

• DPN-100 

— PMs 

— OAs 

— PM-PEs 

— PM-PIs 

CMC*logToFile If the value is set to True, the 
console automatically logs all 
output to a file in the home 
account. The file is called 
CmcLog.YYMMDD-
HHMMSS.PID. If the value is set 
to False, the console does not 
automatically log output to a file. 

The default value is False.

True or False

CMC*logFilePath This resource specifies the 
pathname of the log file in the 
home account. 

The default is CmcLog.<date 
time>.<pid>.

CMC*logAppend If the value is set to True, the 
output is appended to a log file if 
it already exists. If the value is set 
to False, the output overwrites a 
log file if it already exists.

The default value is False.

True or False

Table 1Resources for customizing the Command Console (Continued)

Resource Description Legal values

 (Sheet 2 of 2)
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— PM-POs 

• Passport nodes and any subcomponent

Note: The Operator Commands tool is also supported on RTRs, ERTRs, 
Hosts, and MDM workstations. Invoking the Operator Commands tool 
on one of these starts a Telnet session to that node name. For this Telnet 
session, a corresponding IP address to node name needs to exist in the /
etc/hosts file.

Operator Commands tool connection configuration
The Operator Commands tool uses information contained in the .nmsrc file 
(located in your $HOME/MagellanNMS directory) to determine which OA/
groups are used to establish a network connection. This connection is 
completed using the same mechanism that the Command Console uses. If a 
network connection on a component is not yet established, the Operator 
Commands tool prompts for authentication information to complete the 
connection. The Operator Commands tool reuses existing network 
connections.

Note: The Operator Commands tool automatically creates a file if one 
does not already exist by using the first used OA or Group as the default 
for future connections.

If you want to define a specific OA destination for a given DPN-100 node, 
add an entry in the following format to the .nmsrc file in your $HOME/
MagellanNMS directory:

[<module name>] OA <OA name> [<userid> [<password>]]

Example: 

R78 OA CORENCS DAVE

If you want to add a specific group destination for a given Passport node, add 
an entry in the following format to the .nmsrc file in your $HOME/
MagellanNMS directory:

[<module name>] GROUP <Group name> [<userid> 
[<password>]]

Example:

NODER2 GROUP NODER2_GRP
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If the module name is omitted and the entry is located at the bottom of the file, 
the destination applies to all other nodes.

Example:

NODEY2CD GROUP NODEY2CD_GRP
GROUP UNIVERSE
OA CORENCS

This example indicates that you need to use connections to 
NODEY2CD_GRP to reach NODEY2CD. UNIVERSE is used for all other 
Passport nodes, and CORENCS is used for all DPN-100s. Ensure that the 
generic line (no module name) appears after the module-specific lines.

Note: If the user name and password are provided, connections are 
performed automatically.

Prefix fundamentals
Using Command Console prefixes can help you when you need to issue 
multiple commands to either the same device or the same components, or 
both. Using prefixes saves you keystrokes since prefixes are automatically 
added to the command entry area for use in subsequent commands. You can 
create static prefixes or you can enable automatic prefix mode.

Static prefixes 
You can specify a prefix to use for all subsequent commands. This prefix is 
static, that is, the prefix remains in effect until explicitly modified or deleted.

Automatic prefix mode
You can also use automatic prefix mode to set prefixes. When you enable 
automatic prefix mode, the Command Console converts a previously 
executed command into a device-specific prefix. For example, you can issue 
the configuration sequence of check, save, activate, confirm, and commit 
without having to repeatedly input the module and subcomponent. Automatic 
prefixes are based on the last command issued. Therefore, prefixes can 
change with every command issued. An automatic prefix differs from a static 
prefix in that it need not be the left-most part of the command. 
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The table “Automatic prefix rules” (page 55) outlines the conversion rules for 
automatic prefixes when commands are entered in the command entry area 
(see the format for Command in the table) and when drag and drop techniques 
are used (see the format for Component in the table) and shows the resulting 
prefix. The caret (^) in the table indicates the position of the insertion cursor 
for the next command.

Table 2Automatic prefix rules

Original command or 
dropped component name

Resulting prefix

DPN

Command: <module> <verb...>
Component: PM/<module>

<module> ^

Command: <module> PE <pe> <verb...>
Component: PM/<module> PE/<pe>

<module> PE <pe> ^

Command: <module> <pi> <verb...>
Component: PM/<module> PE/<pe> PI/<pi>

<module> <pi> ^

Command: <module> <pi> <po> <verb...>
Component: PM/<module> PE/<pe> PI/<pi> PO/<po>

<module> <pe> <pi> ^

Command: <module> <comp.> <d|q|?...> <module> <comp.> ^

Other DPN commands and component names <module> ^

Passport

Command: <module> <verb + opts>
Component: EM/<module>

<module> ^

Command: <module> <verb + opts> <subcomponents 
and args...>
Component: EM/<module> <subcomponents...>

<module> ^ <subcomponents and 
args...>
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Setting automatic prefixes
You can set automatic prefixes by the following methods:

• Drag and drop a component or alarm from another fault management tool 
onto the Command Console. This action converts the corresponding 
component name into a prefix in the command entry area. Drag and drop 
components are always converted to prefixes. Drag and drop procedures 
and automatic prefixes produce similar outputs. 

• Select a command in the command history area and then from the 
Options menu, choose Recall History as Prefix (Ctrl+H keyboard 
shortcut). This action converts the command into a prefix in the 
command entry area. If no command is currently selected, the Command 
Console creates a prefix when a command is executed.

You can invoke automatic prefix mode by the following method:

From the Options menu, choose Set Auto-Prefix On (Ctrl+A keyboard 
shortcut). Each time you execute a command, the command is converted to a 
prefix for the next command. 
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Operational Commands GUI

The Operational Commands graphical user interface (GUI) provides an easy-
to-use graphical user interface (GUI) from which to execute commands. The 
Operational Commands GUI supports mulitple GUI sessions and multiple 
commands running concurrently.

Use the Operational Commands GUI to select and run commands on switch 
components from the Preside Multiservice Data Manager. Executed 
commands collect information from components which aid in the execution 
of other tasks, such as configuration or troubleshooting. 

Using the Operational Commands GUI improves operator productivity by 
increasing consistency, hiding unnecessary details, reducing the need to type 
commands.

Prerequisites
The fault access agent server must be running before starting the Operational 
Command GUI tool.

Navigation
• “Operational Command GUI basic procedures” (page 58)

• “Operational Command GUI interface description” (page 68)

• “Operational Command GUI tool fundamentals” (page 76)
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Operational Command GUI basic procedures
Use Operator Commands GUI basic procedures for operations such as 
starting and stopping, or managing the interface of the Operator Commands 
GUI from the Preside MDM toolset and from MDM Operator Client. 

Navigation
• “Starting the Operational Commands GUI tool” (page 59)

• “Running an Operational Command from the GUI” (page 61)

• “Establishing or disconnecting network connections” (page 65)

• “Logging command output to a file” (page 63)

• “Re-executing an Operator Command” (page 67)

• “Exiting the Operator Commands GUI” (page 67)
241-6001-804   15.1RSUP   



Chapter 3 Operational Commands GUI   59
Starting the Operational Commands GUI tool
Use this procedure to start one or two Operator Commands GUI sessions to 
gather information from the switch about specific components. 

You can start the Operational Commands GUI from the Preside Multiservice 
Data Manager (MDM) Toolset, the MDM Operator Client and from the 
following tools:

Procedure steps
1 Make a selection from the table.

2 In the Toolset or the MDM Operator Client window, select System-
>Utilities -> Operator Commands.

The Operator Commands GUI window opens.

If running Toolset If running MDM Operator Client

• Network Viewer

• Component Information Viewer

• Component Status Display

• Network Status Bar

• Alarm Display

• Passport Shelf View

• MPE Shelf View

• Passport Nodal Provisioning

• MPE Nodal Provisioning

• MPE Telnet

• Network Viewer

• Component Information Viewer

• Alarm Display

• Passport Shelf View

• MPE Shelf View

• Passport Nodal Provisioning

• MPE Nodal Provisioning

• MPE Telnet

If starting from Toolset or MDM 
Operator Client main menu, 
see...

If starting from another tool, 
see...

step 2 step 5
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3 From the supporting tool (Network Viewer, Component Information 
Viewer, or Alarm Display), select the component you want to make a 
network connection to. 

4 From the supporting tool, open the Start Tools menu. For details, refer to 
the tool’s documentation. 

5 From the pop-up menu, select Utilities -> Operational Commands.

The Operator Commands GUI tool opens automatically. 

6 If you have not already established an authenticated connection or if you 
want to change the group you are currently authenticated to, select 
Security-> Connection Management.

The Connection Management dialog opens.

7 Click a Group in the Group panel to select a group.

8 Click a UserId in the User List panel to select a UserId or type your UserID 
in the UserID field.

9 Enter your password if the password field is not automatically populated.

10 Click OK.

11 Repeat steps 1 to 5 to launch a second GUI.
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Running an Operational Command from the GUI 
Use this procedure to select a component and execute a command on that 
component using the Operational Commands GUI. 

Procedure steps
1 Start the Operational Commands GUI. Use “Starting the Operational 

Commands GUI tool” (page 59) to complete this step.

2 Establish a connection to the target component. Use “Establishing or 
disconnecting network connections” (page 65) to complete this step.

3 From the Operational Command GUI Component drop down list, select 
a component or type the component name in the Component field. 

Note:  The command selections vary depending on the type of 
component you choose.

Specify multiple component instances by entering their values after the 
lowest level component in the Component field. 

A forward slash after a component name indicates that there are multiple 
instances of that component. Specify the instance for each of these 
components by doing one of the following: 

• Type the number of each component instance to be polled. Use a 
semi-colon to separate each component instance from the next. 
Pressing the right arrow on the keyboard moves the cursor to the 
next component that requires a component number. 

• Type the wild-card “*” to poll all instances of the component. The 
Operator Commands GUI tool makes appropriate command 
selections available.

4 From the Operational Command GUI Command drop down list, select a 
command. 

If you have not already established an authenticated connection to the 
target component, the Group Authentication dialog opens when you 
launch a command. 

5 On the Group Authentication dialog, click the down arrow next to the 
Group Name field and select a group. 

6 On the Group Authentication dialog, click the down arrow next to 
UserID field and select a user ID.

7 On the Group Authentication dialog, enter your password if the 
password field is not automatically populated.
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8 Click OK.

9 If the command does not require user input, the command is automatically 
executed and the results are displayed in the Output Area. The command 
is listed in the Status History area.

If the command requires user input, a command-specific dialog opens 
and must be completed by the user. Click Help for context sensitive help. 

10 Execute additional commands while waiting for a previously executed 
command to return a result, or execute a previously executed command 
by clicking on a command in the Status History area.

View the results of previously executed commands by scrolling up the 
Output area.
241-6001-804   15.1RSUP   



Chapter 3 Operational Commands GUI   63
Logging command output to a file
Use this procedure to specify a file that automatically saves all command 
responses. Depending on the macro, some command output is provided in .txt 
format and other command output is provided in .html format. 

Procedure steps
1 On the File menu, choose Save As. 

The Save dialog opens. 
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2 Specify the path and file where the logs are to be stored by selecting the 
appropriate entries in the Folders and Files lists. Alternatively, you can 
type the path name and file name in the Selection fields. 

3 Select a filter type, txt or html, from the Filter drop-down.

4 If a log file currently exists and you want to append to it with the new 
responses, click Update. If you want to overwrite an existing file or start 
writing to a new file, click Save.

5 To discontinue command response logging, click Cancel.
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Establishing or disconnecting network connections
The Operational Commands GUI can establish communications with 
multiple devices and components through the Connection Manager. The 
actual connection process is transparent.

Procedure steps
1 In the application main window, select System -> Utilities -> Operational 

Commands. 

2 On the Security menu, choose Connection Management. 

The Connection Management dialog opens. The list of available groups 
is displayed in the Groups panel. The currently selected group is checked. 
The list of current users is displayed in the User_Id panel. 

Note: While you may connect to a DPN group through the Connection 
Manager, DPN commands are not supported in the Operational 
Commands GUI.

3 Click on a group listed in the Groups panel to make a group selection. 
Alternatively, type a group name in the Destination: field.

The selected group name is displayed in the Destination: field. If a 
connection already exists, the Disconnect button replaces the Connect 
button.

If connecting, see... If disconnecting, see...

step 4 step 6
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4 Type your user ID and password in the User ID and Password fields. 
Alternatively, click on an entry in the User List panel to make an entry in 
the User ID field.

Note:  All User IDs entered during the current session are listed in the 
User List panel. Clicking a User ID from the User List panel pastes both 
User ID and password information in these fields. 

5 Click Connect to establish a network connection.

When the connection is complete, the Connection Management Dialog 
remains open to allow you to make other connections at another time. 

All components that are authenticated by this group are made available 
for selection from the Component drop down on the main window. 

6 Click Disconnect to establish a network connection.

7 Click Close to close the Connection Management Dialog. 
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Re-executing an Operator Command
Use this procedure to re-execute an Operator Command from the Status 
History area. 

Procedure steps
1 From the Status History area, right click on the row that displays the 

command you want to re-execute.

2 From the drop-down menu, select the Re-execute for...command on the 
component. A maximum of two re-execute commands may be listed. 

The drop-down re-execute command typically applies to the component 
on which the command was last executed. However, if another 
component is currently active, that is, you have changed the component 
in the Component text box, and the command may be executed on the 
currently active component, then the drop-down lists a Re-execute for... 
command for the current component as well as the previously active 
component.

Exiting the Operator Commands GUI 
Use this procedure to exit the Operator Commands GUI. 

Procedure steps
1 From the File menu, select Exit

The open window closes and history for the session is discarded.
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Operational Command GUI interface description
The Preside Multiservice Data Manager (MDM) Operational Commands 
GUI provides operators with the ability to select and execute a select number 
of commands through an easy-to-use graphical user interface (GUI). 

This tool is launched from the MDM Toolset, MDM Operator Client, or from 
other MDM applications, and allows the operator to collect information from 
the switch to aid in the execution of other tasks. 

The Operational Commands GUI supports multiple commands running 
concurrently. In some cases, the GUI prompts the operator to enter the input 
parameters before the command is executed. 

The Operational Commands GUI consists of the following:

• "Menu bar" on page 69

• "Component selection" on page 70

• "Command selection" on page 71

• "Output area" on page 71

• "Status history area" on page 72

• "Dialog boxes" on page 73
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Figure 3
Operational Commands GUI window

Menu bar
The menu bar at the top of the window consists of the following menus:

• “File menu” 

• “Security menu” 

• “Help menu” 

File menu
The File menu contains the following commands:

Save As Provides a command to save command output to 
a file. Opens the Save As dialog.

Exit Provides a command to exit the Operational 
Command GUI tool. 

FCAPS menus

Menu bar

Output area

Status history 
area

Component and Command selection area
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Security menu
The only command that is available from the security menu is the Connection 
Management command. The Connection Management command opens the 
Connection Management dialog which allows you to manage 
connections to devices and components.

Help menu
The Help menu contains the following commands.

Component selection
The component selection area allows the user to enter a component name or 
select a component from the drop down menu. Only components that are 
accessible for the authenticated group are available. 

Table 3 lists and describes the options available from the Component 
selection area.

On Window Provides a description of the window.

What’s This? Displays online help information for objects in the 
window.

Table 3
Component drop down menu items

Command Description

<component name> Allows the user to type in the component name 
into the Component text box.

Displays the target component. 

Allows the user to select a component from the 
drop-down menu. The drop-down menu lists the 
six most recent components typed in by the user.

GetContext Displays the current context or the context of the 
previous component entered in Component text 
box.
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Component and Command selection 

Command selection
The command selection area allows the user to select a command from the 
drop down menu. Only commands that can be used for the selected 
component are available for selection. For a list of supported commands, see 
“Supported command macros” (page 77).

The command drop down menu contains the following options:

Output area
The output area displays both the operational command and the response to 
the command. Each command in the command response area has an 
associated sequence number (shown in the Status history area, under the 
column heading Command) for easy reference. 

Table 4
Command drop down menu items

Command Description

<command name> Displays the list of commands that can be 
executed for the component displayed in the 
Component text box.
Note: DPN commands are not supported in the 
Operation Commands GUI. If a DPN component 
is selected, no DPN commands are listed in the 
selection drop down menu.
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If a response to a command is interspersed with responses from other 
commands, the command text is followed by the string …continued…. The 
end of the response for any command is indicated by a line that contains the 
command number and the string Request Completed. 

To save the contents of the command response area, use one of the following 
methods:

•  Save As command which saves the command response area to a file

• cut and paste to extract portions of the response text

• use drag and drop techniques to select portions of text to drop onto the 
printer icon in the common desktop environment (CDE) Front Panel 

Status history area
The Status history area displays a list of previously executed commands in a 
last used order. The number of commands displayed depends on the number 
you have configured in your user preferences file. The default is twenty five. 

Each command in the Status history area is listed in the Status history table. 
The Status history table has the following columns:

Status A green check mark indicates that the command 
was executed successfully. A red X indicates that 
the command was not executed.

Command Number The sequence number the executed commands.

Command Name The name of the command.

Component Name: The name of the component the command was 
performed on.

Start Time Specifies the time when the command began its 
execution.

End Time Specifies the time when the command ended its 
execution.

Return Code Indicates command execution success or error.
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All commands except for connect and disconnect are added to the Status 
history table. Each entry has a sequence number that is used to associate a 
command with its response. 

The list of commands in the Status history area can also be used to re-execute 
a previous command. This is done by double-clicking on an entry in the 
command history, or using the mouse select button on an entry. 

Dialog boxes
The Operational Command GUI provides the following dialogs:

• “Connection Management dialog” (page 73)

• “Save dialog” (page 74)

Connection Management dialog
The Connection Management dialog allows you to select a group and user for 
authentication. Group authentication enables access to authorized network 
destinations. 

This dialog has the following areas:

Menu Bar:

File Consists of the Exit command.

Groups Consists of commands to connect and 
disconnect a group.

Help Consists of commands to display online 
information in a Web browser.

Group: Lists all previously authenticated groups. The 
active group is the group that is checked. 

User List: Lists all previously authenticated user IDs 
associated with the selected group and allows 
you to re-use authentication data. Click on a user 
ID to populate the User ID field.

Destination Type a group name into this field rather than 
selecting one from the Group List.
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Connect Management dialog

Save dialog
The Save dialog lets you specify the file for logged command output.

UserID box Type a user ID into this field rather than selecting 
one from the User ID List.

Password box Type a password into this field if the field has not 
already been populated. 

Command buttons:

Connect Click to connect performs authentication with the 
Fault Access Agent.

Close Click to close the connection.

Folder:  
Enter path or folder 
name box

Specify the path to the log file.

Folder panel Displays folders in the specified location.
File Name: Specify the log file name.

Enter the file name box Displays the results of the search. Click on an 
entry in the list to select a device.

Files panel Displays files in the specified location.
Filter: Selects a filter type: .txt or .html.
Command buttons:

Save Click to discard the contents of an existing file 
when logging starts and begins logging the new 
content.
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Save dialog

Update Click to append log command output to the 
specified file.

Cancel Click to close the dialog without logging.
Help Click to display online information in a Web 

browser.
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Operational Command GUI tool fundamentals
The Operational Command graphical user interface (GUI) has two 
architecture levels: the server level and the user interface level. 

When a command is invoked from a GUI on the Preside Multiservice Data 
Manager (MDM) client machine by the operator, it triggers the execution of 
a macro on the MDM server machine. When the macro has completed, the 
output is displayed to the operator by way of the GUI on the MDM.

An MDM macro is a Solaris executable that is integrated with the MDM base 
infrastructure. Because a macro is a Solaris executable, it can be a shell script 
or a C++ program, and has full access to the local Solaris environment. An 
MDM macro can also be invoked from Command Console or from the Solaris 
command line. 

The relationship between server and tool interfaces is shown in the following 
figure.
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Operational Commands GUI architecture

Supported command macros
The command macros in the following table are supported in the Operational 
Commands GUI. For a description of these command and macros, see the 
appropriate diagnostic commands sections in the Component Information 
Viewer chapter of the 241-6001-011 Preside MDM Fault Management User 
Guide.
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Table 5
Supported commands and macros

Passport Commands and Macros MPE 9500 Commands and Macros

Describe Component Display interfaces brief

List Comps Display interfaces terse

Display LPs Display interfaces detail

Display LP Display interfaces extensive

Display Cards List configuration

Display Trunks Display default configuration

Display Software List system configuration

Display Provisioning Display system default configuration

List Subcomps List routing configuration

List Files... Display routing default configuration

Display Connections List policies configuration

Display Troubled Connections Display policies default configuration

Display Stats Delta... Display route brief

Ping IP Address Display route terse

Trace AtmIf Circuit Display route detail

Trace AtmIf Path Display route extensive

Ping DPRS Node Display hidden routes

Trace PORS Connection Display route summary

Port Interface Test... Display inactive routes

Module Report Display damped routes

Card Report Display all routes

Software Report Display all active routes

Trunk Report Display ospf default route

ATM Report Display ospf route

FrameRelay Report Display isis default route

 (Sheet 1 of 2)
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. Display isis route

. Clear ospf statistics

.. Clear ospf neighbor

. Clear isis statistics

. Clear isis neighbor

. Clear rip statistics

. Clear bgp neighbor

. Display bgp/ospf database

. Display bgp/isis database

Table 5
Supported commands and macros (Continued)

Passport Commands and Macros MPE 9500 Commands and Macros

 (Sheet 2 of 2)
Preside MDM Workstation Utilities User Guide   15.1RSUP



80   Chapter 3 Operational Commands GUI
241-6001-804   15.1RSUP   



81
Chapter 4
Remote Access

This chapter describes Remote Access, a utility that lets you access a remote 
host that supports the VT100 user interface either through an X.29 PAD 
session or a Telnet session. 

This chapter contains the following:

• “The Remote Access tool” (page 81)

• “Starting the Remote Access tool” (page 82)

• “Starting a Remote Access session” (page 83)

• “Stopping a Remote Access session” (page 86)

• “Stopping the Remote Access tool” (page 87)

• “Using the keyboard” (page 87)

The Remote Access tool
The Remote Access tool lets you access a remote host that supports the 
VT100 user interface either through an X.29 PAD session or a Telnet session.

The Remote Access main window contains a Session list that displays all 
active remote sessions. You can access a host by typing the remote host name 
or address in the text entry field, or you can use the Get context menu 
selection. 
Preside MDM Workstation Utilities User Guide   15.1RSUP



82   Chapter 4 Remote Access
To start a Telnet session from the text entry field, you can type an IP address, 
a host name known as an IP host to the workstation, a component identifier 
of an SNMP device, or a host name known as a module by the Host Group 
Directory Server (HGDS). 

To start an X.29 PAD session from the text entry field, you can type a DNA, 
or a host name that has been configured on the workstation as an X.25 host.

You can establish up to ten concurrent Remote Access sessions from the 
workstation, but you cannot set up more than one session with the same host. 
Each Remote Access session provides an 80-character wide by 25-line tall 
VT100-like window and a corresponding entry in the Session list.

See also...

• “Starting a Remote Access session” (page 83)

• “The Session list” (page 84)

• “Host text entry field and Get context menu” (page 85)

• “Start access button” (page 85)

• “Stopping a Remote Access session” (page 86)

• “Stopping the Remote Access tool” (page 87)

• “Using the keyboard” (page 87)

Starting the Remote Access tool
1 In the application main window, select System -> Utilities -> Remote 

Access.

The Remote Access window opens.
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Figure 4
Remote Access window

Starting a Remote Access session
Before starting a Remote Access session using the Get context (see step 3), 
the host name must be in context in the Component Information Viewer, or 
Component Status Display. Refer to the appropriate sections on Network 
Viewer, Component Information Viewer, or Component Status Display in 
241-6001-011 Preside MDM Fault Management User Guide for details.

1 Start a Remote Access Telnet session: 

Start a Remote Access Telnet session one of the following ways:

• Type an IP address in the data entry field and click the Start access 
button.

• Type a host name known as an IP host to the workstation in the data 
entry field and click the Start access button. 

You can also make your host known by its node name by entering your 
node name and IP address in the /etc/hosts file or in the NIS or NIS+ 
system.

• In the data entry field, type the host name of the node and click the 
Start access button. The host name must be known to the Host 
Group Directory Server (HGDS).
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• Type the name of an SNMP device, including the node type (for 
example, EM is a node type) in the data entry field and click the Start 
access button.

2 Start a Remote Access X.29 PAD session:

Start a Remote Access X.29 PAD session one of the following ways 

• Type a DNA in the text entry field and click the Start access button.

• Type a host name that has been configured on the workstation as an 
X.25 host in the text entry field and click the Start access button. Use 
the tool x25tool from SunLink X.25 to configure the host name.

3 Start a remote access session:

a. Choose the data selector at the right of the data entry field 

b. Choose Get context. 

A Remote Access session for the host starts and the host name is 
displayed in the Session list in the main window of the Remote Access 
tool. Each remote session has a separate window.

See also...

• “The Session list” (page 84)

• “Host text entry field and Get context menu” (page 85)

• “Start access button” (page 85)

• “Receiving an error” (page 86)

• “Receiving a confirmation” (page 86)

The Session list
Each Remote Access session has a corresponding entry in the Session list. 
The session list shows the remote sessions that are in progress.

A popup menu is available once you select a session in the Session list. The 
popup menu contains the following commands:

• Show session - brings the selected session to the top of the display. It may 
or may not have been iconified. You can also double-click on a session 
in the Session list to bring it to the top of the display.

• Stop session - terminates the selected Remote Access session. The entry 
is removed from the Session list.
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See also...

• “Receiving a confirmation” (page 86)

• “Stopping a Remote Access session” (page 86)

Host text entry field and Get context menu
You can access a host using the host text entry field and the Get context menu 
selection. 

Accessing a host using the host text entry field
1 Type the remote host name or address in the Host text entry field.

2 Click the Start access button.

The host name is retrieved from the host text entry field.

Accessing a host using the data selector
1 From the data selector, choose Get context.

The host name is retrieved from the context server.

See also...

• “The Session list” (page 84)

• “Starting a Remote Access session” (page 83)

Start access button 
Start a remote session using the name or address in the Host text entry field.

Starting a remote session
1 Click the Start access button.

A VT100-like window opens with the remote session. 

If the Host text entry field is empty, the workstation will beep.

See also...

• “Host text entry field and Get context menu” (page 85)

• “Starting a Remote Access session” (page 83)
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Receiving an error
When 10 remote access sessions are already open and you attempt to open a 
new one, an error dialog opens informing you that the maximum number of 
sessions are already open. 

When a remote access session is already open to a host and you attempt to 
open a new session to the same host, an error dialog opens informing you that 
a session is already open to that host. 

Closing the error dialog
1 Click the OK button. 

The request to open a new session is cancelled. 

Receiving a confirmation
When you request the stopping of a remote access session, a confirmation 
dialog opens requesting you to confirm.

When some remote access sessions are open and you select Exit from the File 
menu, a confirmation dialog opens warning you that the open sessions will be 
terminated and requesting you to confirm.

Confirming to stop a remote access session
1 If you want to continue your request, click the Yes button.

If you want to cancel your request, click the No button.

See also...

• “Stopping a Remote Access session” (page 86)

Stopping a Remote Access session
When you exit the Remote Access tool, all active sessions close. If you want 
to terminate a remote session without quitting the tool, follow this procedure.

1 Select the session to be terminated in the Session List.

2 Choose Stop session.

3 Click the Yes button to confirm.

The session is removed from the screen and the session no longer is 
displayed in the Session List.
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Another way to stop a Remote Access session is to close the session’s Xterm 
or UNIX window. When the session’s window is closed, the session is 
removed from the Session List on the Remote Access tool. For example, one 
way to exit from the session window is to type exit and press Return. Once 
the session window closes, the session is removed from the Session List.

Stopping the Remote Access tool
To stop the Remote Access tool, from the File menu, select Exit or press 
Ctrl+E. Any open Remote Access sessions are terminated.

Using the keyboard
The Remote Access tool provides the following command shortcuts:

• Ctrl+E exits the Remote Access tool.

See also...

• “Mnemonics” (page 87)

Mnemonics
Some characters in menus and menu items have an underscore. These are 
mnemonics that you can use instead of using the mouse. 

You can use the following keys in combination with the mnemonics: 

• Meta key. For example, Meta-F X opens the File menu and exits Remote 
Access.

• F10 key. For example, F10 F X opens the File menu and exits Remote 
Access.

See also...

• “Using the keyboard” (page 87)
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Chapter 5
Online Documentation

This section describes the Preside Multiservice Data Manager (MDM) Online 
Documentation. This section contains the following topics:

• “About Online Documentation” (page 89)

• “Troubleshooting Online Documentation” (page 91)

About Online Documentation
Preside Multiservice Data Manager (MDM) Online Documentation is an 
online documentation and help facility supplied with the MDM software. 
This facility provides online help information using a Java-enabled browser 
and provides platform independence as a distributed application. 

Using the Online Documentation, you can access the complete set of MDM 
technical publications. A navigation frame assists you to navigate through the 
available documentation.

You can also access context-sensitive help information for MDM software 
applications. This context-sensitive information includes help information for 
application windows and dialogs, alarms, and software configuration.

Setting the NMSWEBBROWSER variable
If the Netscape application is not installed in the directory /usr/dt/appconfig/
netscape, change the environment variable NMSWEBBROWSER to the 
actual path.

1 Close all Preside Multiservice Data Manager (MDM) tools and associated 
help windows.
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2 To determine the Netscape path, type the following command:

which netscape

The path to Netscape is indicated.

3 Set the NMSWEBBROWSER environment variable.

setenv NMSWEBBROWSER <Netscape path>

where:

<Netscape path> is the path to the directory in which Netscape is 
installed. Use the Netscape path indicated in step 2.

Or, set the environment variable in file /opt/MagellanNMS/bin/nmscsh and 
then source the modified file.

source /opt/MagellanNMS/bin/nmscsh

Starting Online Documentation
1 Start the Preside Multiservice Data Manager (MDM) toolset:

/opt/MagellanNMS/bin/nmstool &

The application main window opens. 

2 You can start Online Documentation by either of the following methods:

a. From the MDM or Operator Client window, select System -> Utilities 
-> Online Documentation. 

b. From within an MDM tool, select a Help item from the Help menu. 

A Web browser opens with the requested tool information.

Getting help
Most Preside Multiservice Data Manager (MDM) tools provide a Help menu 
to view online help about the tool in context. The Help menu provides the 
following types of help information. 

• “Help on Context” (page 90)

• “Help on Window” (page 91)

Help on Context
 MDM context-sensitive help lets you view online help related to MDM tools. 
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To start context-sensitive help, from the Help menu, select Help on Context. 
When the cursor changes to a question mark, select any object in the window. 
After you make a selection, the help information associated with that object 
displays in the Online Documentation window. 

Help on Window
This menu item displays a brief description of the currently selected window.

Troubleshooting Online Documentation
The following procedure is intended to troubleshoot the main cause of online 
documentation failure.

No help information displays in Online Documentation
If the required software for Online Documentation is installed but help 
information does not display in the Netscape window, use the following 
procedure.

1 Ensure that the Tomcat application is running by using the ps command.

ps -ef | grep java

If Tomcat is running, you should see a process similar to the following:

root 16016     1  0 16:09:58 ?        0:16 
/opt/nortel/3rd_party/java/current_jre/bin/java -
Djava.endorsed.dirs=...

2 If Tomcat is not running, launch Tomcat by typing

/etc/init.d/jtomcatctl404 stop 

If Tomcat is already running, restart Tomcat by typing

/etc/init.d/jtomcatctl404 stop

/etc/init.d/jtomcatctl404 start

No user-defined alarm help displays in Online Documentation
If you add or modify alarm help information in the Online Documentation 
and this information does not display, use the following procedure.

1 Ensure the directory /opt/MagellanNMS/data/alarms/UserAlarms exists 
and contains files and ensure that the files and directories have adequate 
read permissions.
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2 Log on as root and restart Tomcat.

/etc/init.d/jtomcatctl404 stop

/etc/init.d/jtomcatctl404 start

3 Restart MDM.

/opt/MagellanNMS/bin/nmstool

Mnemonics
In the menus of the Preside Multiservice Data Manager (MDM) tools, some 
characters have an underscore. These are mnemonics that you can use instead 
of using the mouse to open a menu and select a menu item.

You can use the following keys in combination with the mnemonics: 

• Meta key
For example, Meta-H W opens the Help menu and selects On Window.

• F10 key
For example, F10 H W opens the Help menu and selects On Window
241-6001-804   15.1RSUP   



93
Chapter 6
Memory Utilization tool

This chapter describes Memory Utilization, a utility that provides you with 
the amount of virtual memory available on the workstation. This chapter 
contains the following:

• “The Memory Utilization tool” (page 93)

• “About virtual memory” (page 94)

• “Starting Memory Utilization” (page 94)

• “File menu” (page 95)

• “Configuring Memory Utilization” (page 95)

• “Using the keyboard” (page 96)

The Memory Utilization tool
The Memory Utilization tool displays information about the amount of virtual 
memory available on the workstation. It displays the percentage of virtual 
memory currently in use on the Preside Multiservice Data Manager (MDM) 
workstation in a bar graph.

The Memory Utilization display shows the virtual memory used and the 
amount still available on the workstation. This information is displayed in 
megabytes. 

The horizontal bar graph shows the percentage of memory used. On a color 
monitor, the bar changes color as follows:

• green indicates an acceptable amount of free memory
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• red indicates a low amount of free memory (less than 10% of memory is 
available)

When the low memory threshold is crossed, a log appears in the System Log 
Display and a message is displayed on the console.

The bar graph is updated regularly to display the current memory. 

See also...

• “About virtual memory” (page 94)

• “File menu” (page 95)

• “Configuring Memory Utilization” (page 95)

• “Using the keyboard” (page 96)

About virtual memory
Virtual memory is the memory that all applications on the workstation have 
available to them. The amount of virtual memory is determined by the amount 
of swap space configured on the workstation. When the available virtual 
memory is exhausted, no more processes can be run, while existing processes 
may encounter problems.

Memory utilization is important because Preside Multiservice Data Manager 
(MDM) tools only function properly if there is sufficient memory available. 
If problems are encountered that are believed to be related to insufficient 
memory, this tool can be used to monitor memory usage and to guide in 
making procedures for tool usage that avoid memory exhaustion. 
Alternatively, a consistently low amount of available memory may indicate 
that additional workstation virtual memory is required.

Refer to 241-6001-101 Preside MDM Engineering Guide for details on 
workstation engineering.

Starting Memory Utilization
1 In the application main window, select System -> Utilities -> Memory 

Utilization.

The Virtual Memory Utilization window opens.
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If the Memory Utilization tool cannot get the memory information when you 
launch it, you will be asked to restart the tool.

Figure 5
Memory Utilization tool

File menu
The File menu contains the following command:

• Exit stops the Memory Utilization tool.

Configuring Memory Utilization
The low memory threshold, acceptable amount of memory color, and low 
amount of memory color can be set by command line options or X Toolkit 
resources. The options related to color can only be seen when the tool is run 
on a color monitor.

To set the threshold to mark the transition between an acceptable and a low 
amount of memory, enter the following command:

-t <number_between_0_and_100>

The appropriate value for the threshold is very dependant on the workstation 
configuration, the mix of Preside Multiservice Data Manager (MDM) tools 
being used, and on the amount of information (network size, service data size, 
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alarm rate) being processed. The threshold value is best arrived at by 
monitoring memory utilization and determining when a low memory 
condition occurs. The default value is 90.

Enter the following command to set the bar color when the amount of 
memory used is less than the low memory threshold percentage:

-ok <color>

Enter the following command to set the bar color when the amount of 
memory used is greater than or equal to the low memory threshold 
percentage:

-low <color>

Example
The default tool parameters can be set by starting the tool as follows:

/opt/MagellanNMS/bin/mem -virtual -t 90 -ok 
      forestgreen -low red

Using the keyboard
The Memory Utilization tool provides the following command shortcut:

• Ctrl+E exits the Memory Utilization tool.

See also...

• “Mnemonics” (page 96)

Mnemonics
Some characters in menus and menu items have an underscore. These are 
mnemonics that you can use instead of using the mouse. You can use the 
following keys in combination with the mnemonics: 

• Meta key. For example, Meta-F X opens the File menu and exits Memory 
Utilization.

• F10 key. For example, F10 F X opens the File menu and exits Memory 
Utilization.

See also...

• “Using the keyboard” (page 96)
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Chapter 7
Network Model Shared Memory Utilization 
tool

This chapter describes Network Model Shared Memory Utilization, a utility 
that provides you with the amount of shared memory available on the 
workstation. This chapter contains the following:

• “The Network Model Shared Memory Utilization tool” (page 97)

• “About shared memory” (page 98)

• “Starting Network Model Shared Memory Utilization” (page 99)

• “File menu” (page 100)

• “Configuring Network Model Shared Memory Utilization” (page 100)

• “Using the keyboard” (page 101)

The Network Model Shared Memory Utilization tool
The Network Model Shared Memory Utilization tool displays information 
about the amount of shared memory available on the workstation for the 
network model. It displays the percentage of shared memory currently in use 
on the Preside Multiservice Data Manager (MDM) workstation in a bar 
graph. Use this tool to monitor the shared memory when a new network 
model is loaded.

The Network Model Shared Memory Utilization display shows the network 
model shared memory used and the amount still available on the workstation. 
This information is displayed in megabytes. 
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The horizontal bar graph shows the percentage of shared memory used. On a 
color monitor, the bar changes color as follows:

• green indicates an acceptable amount of free memory

• red indicates a low amount of free memory (less than 10% of memory is 
available)

When the low memory threshold is crossed, a log appears in the System Log 
Display and a message is displayed on the console.

The bar graph is updated regularly to display the current memory, especially 
while a new network model is being loaded.

See also...

• “About shared memory” (page 98)

• “File menu” (page 100)

• “Configuring Network Model Shared Memory Utilization” (page 100)

• “Using the keyboard” (page 101)

For more information on network models, refer to 241-6001-015 Preside 
MDM Network Model Administrator Guide. For more information on how to 
increase the amount of shared memory, refer to 241-6001-303 Preside MDM 
Administrator Guide.

About shared memory
Shared memory is the memory that is used to store the active Surveillance 
Network Model. When the Network Model Coordinator (NMC) is started, it 
reserves as large an amount of shared memory as it can (or as much as 
indicated by its -s command line argument). This memory is shared by the 
active model and the applications that use it, such as the Network Model 
Server, CSD, and Component Provisioning.

A consistently low amount of available shared memory may indicate that 
additional workstation memory is required. Contact your system 
administrator, or refer to 241-6001-101 Preside MDM Engineering Guide 
and 241-6001-303 Preside MDM Administrator Guide.
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Note: Increasing the amount of physical memory (RAM) on a 
workstation does not increase the amount of shared memory (although it 
will likely increase performance). The workstation's kernel must be 
reconfigured to make use of the added memory. 

Starting Network Model Shared Memory Utilization
The Network Model Shared Memory Utilization tool must be started before 
a network model is loaded.

When the Network Model Coordinator (NMC) is started, it uses the value of 
the shared memory segment size defined during the Preside Multiservice 
Data Manager (MDM) configuration and reserves as big a piece of shared 
memory as it can. Alternatively, NMC supports a -s option that lets you 
specify the amount of shared memory (in Megabytes) that you want to 
allocate. The memory is shared by the active model and the applications that 
use it. A consistently low amount of available shared memory may indicate 
that more shared memory is required.

1 In the application main window, select System -> Utilities -> Network 
Model Shared Memory Utilization.

The NM Shared Memory Utilization window opens.

2 Several conditions may impact the display on the NM Shared Memory 
Utilization window.

These conditions are displayed in Table 1.

Table 6

If... Then... Reason: The...

the text above the bar graph 
indicates an error and asks you to 
restart the tool

restart the tool shared memory 
segment is not 
present or was 
lost while the tool 
was opened.

the text above the bar graph 
displays that no shared memory is 
in use by MDM.

there is nothing to 
view; restart the 
tool if the NMC is 
started

shared memory 
segment is not 
currently in use by 
MDM
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Figure 6
NM Shared Memory Utilization tool

File menu
The File menu contains the following command:

• Exit stops the Network Model Shared Memory Utilization tool.

Configuring Network Model Shared Memory Utilization
The low memory threshold, acceptable amount of memory color, and low 
amount of memory color can be set by command line options or X Toolkit 
resources. The options related to color can only be seen when the tool is run 
on a color monitor.

the text above the bar graph says 
that the system cannot get shared 
memory information and asks you 
to restart the tool.

restart the tool tool was unable to 
get shared 
memory 
information

the tool is taking long to open wait: the tool will 
open once the 
model is loaded

tool was started 
while the model 
was loading

Table 6

If... Then... Reason: The...
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To set the threshold to mark the transition between an acceptable and a low 
amount of memory, enter the following command:

-t <number_between_0_and_100>

The appropriate value for the threshold is very dependant on the workstation 
configuration, the mix of Preside Multiservice Data Manager (MDM) tools 
being used, and on the amount of information (network size, service data size, 
alarm rate) being processed. The threshold value is best arrived at by 
monitoring memory utilization and determining when a low memory 
condition occurs. The default value is 90.

Enter the following command to set the bar color when the amount of 
memory used is less than the low memory threshold percentage:

-ok <color>

Enter the following command to set the bar color when the amount of 
memory used is greater than or equal to the low memory threshold 
percentage.

-low <color>

Example
The default tool parameters could be set by starting the tool as follows:

/opt/MagellanNMS/bin/mem -shared -t 90 -ok forestgreen
      -low red

Using the keyboard
The Network Model Shared Memory Utilization tool provides the following 
command shortcut:

• Ctrl+E exits the Network Model Shared Memory Utilization tool.

See also...

• “Mnemonics” (page 101)

Mnemonics
Some characters in menus and menu items have an underscore. These are 
mnemonics that you can use instead of using the mouse. 
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You can use the following keys in combination with the mnemonics: 

• Meta key. For example, Meta-F X opens the File menu and exits Network 
Model Shared Memory Utilization.

• F10 key. For example, F10 F X opens the File menu and exits Network 
Model Shared Memory Utilization.

See also...

• “Using the keyboard” (page 101)
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Chapter 8
Customer Data Tool

This chapter describes the Customer Data Tool, a utility that provides access 
to the customer database(s). This chapter contains the following:

• “The Customer Data Tool” (page 103)

• “Starting the Customer Data tool” (page 104)

• “Data organization” (page 105)

• “Customer Data Tool main window” (page 107)

• “Working with other MDM tools” (page 120)

• “Setting up the Customer Data Tool” (page 120)

• “Keyboard shortcuts” (page 134)

The Customer Data Tool
The Customer Data Tool provides access to a customer database. Each 
customer database is composed of records that contain information for a 
particular component. This information can be anything, but typically 
consists of phone numbers, contacts, and circuit numbers for a particular 
piece of hardware or DNA. For example, the customer data for a port might 
contain the name and address of the current end user of that port. 

The Customer Data Tool allows you to add, change, query, delete, and view 
customer information. This tool has many uses. For example, it can be used 
to quickly access customer information in the event of a problem or to 
identify all customers on a particular piece of hardware.
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See also...

• “Starting the Customer Data tool” (page 104)

• “Data organization” (page 105)

• “Customer Data Tool main window” (page 107)

• “Working with other MDM tools” (page 120)

• “Setting up the Customer Data Tool” (page 120)

• “Keyboard shortcuts” (page 134)

For information on the Embedded Programming Interface (EPI) Customer 
Database interface, see 241-6001-211 Preside MDM Embedded 
Programming Interface Reference Guide. The Customer Database tool is also 
available for the Component Information Viewer and the Alarm Display tools 
in the Preside Multiservice Data Manager (MDM) fault management toolset. 
For more information, see the Component Information Viewer and the Alarm 
Display chapters in 241-6001-011 Preside MDM Fault Management User 
Guide

Starting the Customer Data tool
You can start the Customer Data tool from the Preside Multiservice Data 
Manager (MDM) window. Or, if your workstation has Hewlett Packard (HP) 
OpenView software installed, you can start the Customer Data tool from the 
HP OpenView Desktop for MDM. 

When you start Customer Data, the tool locates all available customer 
databases. If one database is found, then you can access that database directly. 
If more than one databases is found, the tool displays a list of databases from 
which you can make a selection. Alternatively, you can type a database name 
and its server hostname in the dialog entry fields.

See also...

• “Selecting a database” (page 108)

Starting from the main window
1 On the application main window, select System -> Utilities -> Customer 

Data.
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The Customer Data window opens.

Starting from the HP OpenView Desktop
There are various methods for starting the Customer Data tool from the HP 
OpenView Desktop. Use one of the following procedures.

Starting the Customer Data tool from the HP OpenView Desktop
1 From the HP OpenView Desktop Misc (Miscellaneous)) menu, choose 

Customer Database. 

Starting the Customer Data tool from the Events Categories 
window
1 In the Events Categories dialog, choose Nortel Passport Events.

The browser window opens.

2 From the Nortel Passport Events Browser Action menu, choose 
Additional Actions.

The Additional Actions on Nortel Passport Events window opens.

3 In the Additional Actions on Nortel Passport Events window list box, 
choose Customer Database.

Starting the Customer Data tool from the Start Tool menu
1 Open the Start Tool submenu:

Open the Start Tool submenu using one of the following methods:

• In the Alarm Display window, place the cursor over an alarm and 
press the mouse menu button to display the pop-up Alarm Menu.

• In the Component Information Viewer window, place the cursor over 
an area that shows the events and press the mouse menu button to 
display the pop-up menu.

2 From the pop-up menu, choose Start Tool.

The Start Tool submenu opens.

3 From the Start Tool submenu, choose Customer Data.

Data organization
Each customer data record in the database has two parts: component name 
and component data.
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Component name This is the name of the component under which the 
customer data is stored. Component names are unique upper case strings. You 
must enter a component name in the Component field whenever you retrieve, 
add, change, or delete a customer data record. The following table 
“Component names” (page 106) contains examples of component names:

Note: Component names may also be entered in the Display mode (with 
‘/’ between the category/value pairs as in 
PM/R34 PE/7 PI/7 PO/1.

Component data This area consists of four parts: date, source, customer 
data, and related component.

• Date specifies a date in YYYYMMDD (year-month-day) format. 
Records created or modified by the Customer Data Tool contain the date 
when they were last modified. 

• Source is a three-letter code indicating where the customer data record 
originated or was last updated. MDM appears in this field if the records 
were created or modified by the Customer Data Tool. This field cannot 
be edited.

• Customer Data contains up to 1300 characters of free-format customer 
data (for example, circuit numbers, names, phone numbers).

• Related Component is another component that is related to the customer 
data record. It is recommended that the Related Component field be filled 
in if DNAs are added from the Preside Multiservice Data Manager 

Table 7
Component names

Component type Component name

DNA DNA X01234567890123

Port PM R34 PE 7 PI 7 PO 1

Module PM R34

NCS OA PM R34 OA DPNOA

NCS application PM R34 OA DPNOA APPL APPNAME
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(MDM). You can use the Related Component field to retrieve the related 
component or to retrieve all keys of all components that are the same as 
the related component.

See also...

• “Manipulating customer data” (page 107)

Manipulating customer data
The Component, Customer Data, and Related Component areas may contain 
essentially any value. Component names and related component names are 
always in upper case. Keeping these values consistent, in both format and 
meaning, ensures that this tool provides consistent results when retrieving or 
searching for data. Data in the Component area is always changed to upper 
case. Templates are a good way to ensure that data is consistent.

Customer Data Tool main window
For information on items in the Customer Data Tool main window, see the 
following:

• “File menu” (page 107)

• “Options menu” (page 108)

• “Component field” (page 109)

• “Customer Data area” (page 114)

• “Search area” (page 115)

• “Messages field” (page 120)

File menu
The File menu contains the following command: 

• Exit exits the Customer Data Tool. 

To exit the Customer Data Tool, select Exit or type Ctrl+E.
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Options menu
The Options menu contains the following commands: 

• Turn Auto Update On determines whether the tool will automatically 
attempt to retrieve customer data for component names that are put into 
context from other workstation tools. If auto update is not active, a 
component name put into context may be retrieved by selecting Get 
context from the Component area menu. Selecting this menu item 
toggles the auto update to active, and the menu item Turn Auto Update 
Off appears in place of this menu item. 

• Turn Auto Update Off toggles the auto update to non-active. The menu 
item Turn Auto Update On appears in place of this menu item. 

• Select database lets you select the customer database that the tool 
accesses.

See also...

• “Selecting a database” (page 108)

• “Component field” (page 109)

• “Customer Data area” (page 114)

• “Related Component field” (page 115)

Selecting a database
The Customer Data Tool lets you specify the database that you want to use. 
You can do this when the tool is started, or at any time during a session. 

1 From the Options menu, select Select database.

The Customer Databases dialog opens, and a list of available databases 
is displayed. If no databases are available, the tool displays an 
appropriate message and waits, periodically checking for databases to 
become available.

2 Select a database, or enter the database name and supporting server 
hostname in the entry fields.

3 Click Use Database.

The database name appears in the title bar and a message appears in the 
Messages area indicating the database that you have chosen.

To cancel the database selection, click Cancel.
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If no database servers exist, contact your system administrator for assistance.

Component field
The Component field is used to indicate a component name. The Component 
field contains the following command buttons:

• Retrieve attempts to recover the customer data record for the component 
specified in the Component field. The Customer Data Tool performs a 
hierarchical search. If a record exists, it is displayed. If a match is not 
found with the specified name, the tool continues the search in the 
following manner:

— using the component name in display and canonical format 

— using the immediate parent of the component in both display and 
canonical formats

— using the parent’s parent and so on until a match is found or until 
there are no more parents

Example
If you specify the component EM NODER16 LP 2 DS1 0 and no match 
is found, the Customer Data Tool continues to look for matches by using 
the following:

— EM/NODER16 LP/2 DS1/0

— EM NODER16 LP 2 and EM/NODER16 LP/2

— EM NODER16 and EM/NODER16

Rather than selecting Retrieve from the popup menu, you can enter a string in 
the component field and press the Return key. 
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The Customer Data Tool stops at the first match found, if any.   This way, if 
customer data applies to all ports, for example, this data is stored on the 
common processor component without having to duplicate it on every port. If 
no match is found, the tool displays an error message in the Messages area. 

• Add creates a customer data record for the component specified in the 
Component field. The Date and Source fields are automatically filled in 
with the current date and source of the record. Records cannot be added 
if they already exist in the database. (This menu item is not available if 
the tool was started with the Read Only option.)

• Replace supersedes the contents of the component specified in the 
Component field with the data in the Customer Data area. Records 
cannot be replaced if they do not already exist in the database. (This 
menu item is not available if the tool was started with the Read Only 
option.)

• Delete erases the record for the component specified in the Component 
field. An error message is displayed if the component does not exist in 
the database. (This menu item is not available if the tool was started with 
the Read Only option.)

The Component field also provides a pop-up menu that contains the following 
commands:

• Retrieve attempts to recover the customer data record for the component 
specified in the Component field. The Customer Data Tool performs a 
hierarchical search. If a record exists, it is displayed. If a match is not 
found with the specified name, the tool continues the search in the 
following manner:

— using the component name in display and canonical format 

— using the immediate parent of the component in both display and 
canonical formats

— using the parent’s parent and so on until a match is found or until 
there are no more parents

Example
If you specify the component EM NODER16 LP 2 DS1 0 and no match 
is found, the Customer Data Tool continues to look for matches by using 
the following:
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— EM/NODER16 LP/2 DS1/0

— EM NODER16 LP 2 and EM/NODER16 LP/2

— EM NODER16 and EM/NODER16

Rather than selecting Retrieve from the popup menu, you can enter a string in 
the component field and press the Return key. 

The Customer Data Tool stops at the first match found, if any.   This way, if 
customer data applies to all ports, for example, this data is stored on the 
common processor component without having to duplicate it on every port. If 
no match is found, the tool displays an error message in the Messages area. 

• Add creates a customer data record for the component specified in the 
Component field. The Date and Source fields are automatically filled in 
with the current date and source of the record. Records cannot be added 
if they already exist in the database. (This menu item is not available if 
the tool was started with the Read Only option.)

• Replace supersedes the contents of the component specified in the 
Component field with the data in the Customer Data area. Records 
cannot be replaced if they do not already exist in the database. (This 
menu item is not available if the tool was started with the Read Only 
option.)

• Delete erases the record for the component specified in the Component 
field. An error message is displayed if the component does not exist in 
the database. (This menu item is not available if the tool was started with 
the Read Only option.)

• Copy to Related Component Area copies the text in the Component field 
to the Related Component field. 

• Get Context gets the last component name put into context by any and 
workstation network element tool. 

• Put Context places the name in the Component field into context. 

• Cut cuts the currently selected text into the cut buffer. 

• Copy copies the currently selected text into the cut buffer. 

• Paste pastes the contents of the cut buffer into the text at the current 
cursor position. 
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• Delete erases the currently selected text without saving it in the cut 
buffer. 

• Select All selects all text. 

• Deselect All cancels the current selection. 

See also...

• “Data organization” (page 105)

• “Creating a template for customer data” (page 112)

• “Using a template for customer data” (page 112)

• “Adding customer data” (page 113)

• “Changing customer data” (page 113)

• “Deleting a component” (page 114)

• “Working with other MDM tools” (page 120)

Creating a template for customer data
You can create one data record and use it as a template for all new data records 
you add to the database. This is not a menu option, but rather a set of steps.

1 Enter the name of the template in the Component field.

2 Add the template information in the Customer Data area.

For example, Name, Location, Phone, and Company.

3 From the Component field pop-up menu, choose the Add button.

The template is added to the database.

Using a template for customer data
1 Enter the name of the template in the Item field in the Search area. 

2 From the Item field pop-up menu, choose Search Component Names.

The template name and information appears in the window.

3 Change the name of the component and add the appropriate customer 
data.

4 From the Component field pop-up menu, choose the Add button.
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Note:  If you have not changed the name of the component, an error 
message appears in the Messages area indicating that the component 
already exists.

Click on the template name in the Search area to display the template in the 
window.

See also...

• “Search area” (page 115)

Adding customer data
You can add customer data for any component in the network. Customer data 
is stored in a database on the workstation. Every record is referenced by a 
unique component name.

1 Enter the component name in the Component field.

2 Enter the new customer data in the Customer Data area.

3 Enter the related component in the Related Component field.

The related component should be the PE or port for the given DNA.

4 From the Component field pop-up menu, choose the Add button.

A message appears in the Messages area indicating that the component 
has been added. If the component already exists in the database, an error 
message appears.

Changing customer data
You can modify or replace customer data for any component.

1 Enter the component name in the Component field.

2 From the Component field pop-up menu, choose Retrieve.

The customer data is displayed in the Customer Data area. If the record 
is not found, a message appears in the Messages area indicating that the 
component could not be found. 

3 Edit the data. 

4 From the Component field pop-up menu, choose the Replace button.

A message appears in the Messages area indicating that the data has 
been replaced.
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Deleting a component
You can delete customer data from any component in the database. 

1 Enter the component name in the Component field.

2 From the Component field pop-up menu, choose the Delete button.

A message appears in the Messages area confirming the deletion. An 
error is displayed if the record is not found or the database record cannot 
be deleted.

Customer Data area
The Customer area contains the following two fields:

• Date/Source

• Related Component

Note: The Customer Data area accepts a maximum of 1300 characters of 
text. If you try to save data that exceeds 1300 characters, you will receive 
a warning message telling that you cannot save your entry.

Date/Source field
The Date/Source field contains component information. The Date/Source 
field provides a pop-up menu that contains the following commands: 

• Cut cuts the currently selected text into the cut buffer. 

• Copy copies the currently selected text into the cut buffer. 

• Paste pastes the contents of the cut buffer into the text at the current 
cursor position. 

• Delete erases the currently selected text without saving it in the cut 
buffer. 

• Select All selects all text. 

• Deselect All cancels the current selection. 

See also...

• “Data organization” (page 105)
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Related Component field
The Related Component field is used to indicate a related component. The 
Related Component field provides a pop-up menu that contains the following 
commands: 

• Copy to Search Area copies the text in the Related Component field to 
the Item field in the Search area. 

• Copy to Component Name Area copies the text in the Related 
Component field to the Component field. 

• Put Context places the name of the related component into context. 

• Cut cuts the currently selected text into the cut buffer. 

• Copy copies the currently selected text into the cut buffer. 

• Paste pastes the contents of the cut buffer into the text at the current 
cursor position. 

• Delete erases the currently selected text without saving it in the cut 
buffer. 

• Select All selects all text. 

• Deselect All cancels the current selection. 

See also...

• “Data organization” (page 105)

• “Search area” (page 115)

Search area
The search operation scans the entire customer database and returns 
component names of all the records that contain an expression you specify in 
the Search area Item field. The component names of all matched components 
are listed in the Items Matched area. The tool returns a maximum of 5000 
records on any search. If there are more than 5000 records, the search stops 
after the first 5000 records.

You can specify one of three search fields:

• Component name field

• Customer data field (the default)
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• Related component field

Note: The dual format and hierarchical searching described for the 
Retrieve operation do not apply for the Search operation.

Use the Item field in the Search area for search strings. Items that match the 
specified search string are displayed in the search area of the main window. 
The Item field provides a pop-up menu that contains the following 
commands: 

• Search Data searches the customer data fields of all records. You can also 
press Return in the Item field to invoke this operation. 

• Search Component Names searches the component name fields of all 
records. 

• Search Related Component searches the related component fields of all 
records. 

• Cut cuts the currently selected text into the cut buffer. 

• Copy copies the currently selected text into the cut buffer. 

• Paste pastes the contents of the cut buffer into the text at the current 
cursor position. 

• Delete erases the currently selected text without saving it in the cut 
buffer. 

• Select All selects all text. 

• Deselect All cancels the current selection. 

Searching for customer data
1 Enter the expression to search for in the Item field of the Search area.

2 To search using Search data, the default search option, press the return 
key.

To search using another search option, choose a search option from the 
Item field pop-up menu, choose one of the three search options 

The components that match the search appear in the Items Matched 
area.
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See also...

• “Using special symbols” (page 117)

• “Searching examples” (page 118)

• “Items matched field” (page 119)

Using special symbols
You can use certain symbols to achieve more specific results when 
performing a search. For more information, consult the “Regular Expression” 
section of the ed manual page. Type man ed from a UNIX access window for 
details. See the table “Special symbols” (page 117).

Note: Customer data searches are case-sensitive.

Table 8 
Special symbols

Character Matches Example

Any occurrence of the 
specified string

ITI
Find ITI anywhere in the text.
- ‘ITI line’ will match
- ‘New ITI line’ will match
- ‘Previously ITI’ will match

^ Start of text ^ITI
Find ITI at the start of the text.

- ‘ITI lines’ will match
- ‘New ITI line’ will NOT match
- ‘Previously ITI’ will NOT match

$ End of text ITI$
Find ‘ITI’ at the end of text

- ‘ITI line’ will NOT match
- ‘New ITI line’ will NOT match
- ‘Previously ITI’ will match

^ITI line$
Combined start and end - this will match ONLY the 
supplied text - nothing longer, nothing shorter.

 (Sheet 1 of 2)
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Searching examples
The following examples show how you can use the search utility to retrieve 
data.

Example
Find all records that contain the word Critical in the Customer Data area. 

Enter Critical in the Item field. From the Item field pop-up menu, choose 
Search Data (or press Return). The component names of all records that 
match the expression are placed in the Items Matched area.

Example
Find the customer data for a particular DNA. 

Enter the DNA component name (for example, DNA X0123456789) in the 
Component field and press Return.

Example
Find the customer data for a port. 

[characters] One of the characters 
within 
[ ]

[XE]123456789
Find X or E followed by 123456789.

X123456789[0-46]
Find X123456789 followed by a 0, 1, 2, 3, 4, or 6.

[Cc]ustomer
Find customer, with or without a capital “C”

expression* Zero or more 
occurrences of the 
previous expression

X123456[0-5]*
Find X123456 followed by zero or more occurrences 
of the digits between 0 to 5.

.* Displays all records in 
the database

Table 8  (Continued)
Special symbols

Character Matches Example

 (Sheet 2 of 2)
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Enter the port component name (for example, PM R34 PE 7 PI 7 PO 1) in the 
Component field and press the Return key. If the port has no associated data, 
the tool looks for data in its parents (PI, then PE, then PM).

Example
Find all DNAs on a port. 

Enter the port key in the Item field. From the Item field pop-up menu, choose 
Search Related Components. All components with the same port as the 
related component appear in the Items Matched area.

Example
Find all DNAs that begin with X1234. 

Enter X1234 in the Item field. From the Item field pop-up menu, choose 
Search Data.

Example
Find all components with service ITI.

Enter ^ITI in the Item field. From the Item field pop-up menu, select Search 
Data. This example works only if the first line in each customer data record 
is the service type. 

Items matched field
The Items Matched area contains the component names of records that were 
matched by the last search operation. The Items Matched area pop-up menu 
contains the following commands:

• Retrieve retrieves the customer data for the selected record. 

• Copy to Related Component Area copies the component name in the 
Items Matched area to the Related Component field. 

• Copy copies the currently selected text into the cut buffer.

See also...

• “Retrieving information from the Items Matched area” (page 120)
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Retrieving information from the Items Matched area
To retrieve customer data for an item listed in the Items Matched area, select 
the item. Then, from the pop-up menu, choose Retrieve. 

Messages field
The Messages field displays information on the current status of the 
application. The Messages field pop-up menu contains the following 
commands:

• Copy copies the currently selected text into the cut buffer. 

• Select All selects all text in the Messages area. 

• Deselect All cancels the current selection in the Messages area. 

Working with other MDM tools
The Customer Data Tool can work cooperatively with other Preside 
Multiservice Data Manager (MDM) tools that have the ability to put a 
component name into context. These tools include Component Provisioning, 
Network Viewer, Component Information Viewer, Component Status 
Display, Alarm Display, Network Status Bar, and GMDR Administration 
tool. This can be done by selecting a component in one of the tools and 
selecting Put context from the Component field pop-up menu. If the 
Customer Data Tool has Turn Auto Update set to ON (from the Options 
menu) when a component is put into context in another tool, that component 
automatically appears in the Customer Data Tool. Otherwise, the user can 
select Get Context from the Customer Data Tool to retrieve this information. 
For more information on context, the 241-6001-012 Preside MDM 
Configuration Management for DPN User Guide.

Setting up the Customer Data Tool
The figure “Customer data from external sources” (page 127) gives an 
example setup of two Preside Multiservice Data Manager (MDM) 
workstations accessing the same customer data server. 
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Figure 7
Customer Data setup

Administrators can perform the following tasks in order to make the 
Customer Data Tool available to other users.

Creating databases
One or more customer databases must be created. Optionally, you can base 
the number of databases required on the number of Customer Data time 
streams the network is using. It is recommended that there be one database 
for every time stream. The Customer Data time stream corresponds to the 
number of service data time streams you have. Service data time streams are 
discussed in 241-6001-304 Preside MDM Configuration Management for 
DPN Administration. 

These databases must be given unique names and the names should convey 
meaning to the users of this tool.

Creating a database and providing access to the database is done by creating 
a Customer Database Server process for the database. Refer to “Creating a 
new database” (page 124) for more information.
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Populating databases from external sources
Once a database has been created, it may be necessary to populate the 
database using data from a source external to the Preside Multiservice Data 
Manager (MDM). 

You can incorporate data from other sources into the customer database 
provided the data is in the proper format. See the table “External data format” 
(page 132) for a description of this format.

When a data file has been generated, the Customer Database Merge program 
is used to add (or merge) the data into the customer database. This program is 
described in “Combining external data into the customer database” 
(page 126).

Note: Alternatively, you can programmatically populate and query a 
database using the Embedded Programming Interface described in 
241-6001-211 Preside MDM Embedded Programming Interface 
Reference Guide.

Automatic restarting
Once a database has been created (and possibly populated) it should be 
configured so that it can be automatically accessed after a workstation has 
been restarted or software has been upgraded.

This is done by adding a Preside Multiservice Data Manager (MDM) Server 
Manager entry for each customer database server that you want to have 
started. For details, see the 241-6001-303 Preside MDM Administrator Guide 
for more information.

LAN-wide access
By default, the customer database is only accessible by its clients if the 
customer data server process is on the same workstation as the clients or if the 
workstation running the clients is LAN selected to the workstation running 
the server process. This is acceptable as long as all services (such as X.25 
access or customer databases) that a workstation user wants to access are on 
the same host (either the local one or the LAN selected one). However, if they 
want to access, for example, X.25 on one host and a customer data server on 
another, then a LAN-level Multi-nodal Name Server (MNS) must be used. 
Refer to the 241-6001-303 Preside MDM Administrator Guide for more 
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information on the MNS. Note that if the database servers are identified using 
the Select Database dialog’s entry fields, or if the database is running on the 
local workstation, there is no need to deploy a Level 2 MNSD for this 
purpose.

Extracting or deleting records from a database
An administrator should backup a database periodically so that it can be 
recovered in the event of a problem. Also, they may want to remove all 
records from the database that are from a specific source and then add new 
records from that source. The Customer Data Extraction program extracts 
records from a customer database and places them into a file. This file can 
then be used for customized processing.

Customer Data Server
The Customer Data Server is the sole manager of customer data on the 
Preside Multiservice Data Manager (MDM). Each server provides 
LAN-wide, concurrent customer data access for one customer database. The 
server provides service to the Customer Data Tool and the Customer Data 
Extraction and Merge programs. Refer to the 241-6001-303 Preside MDM 
Administrator Guide for more information on the multi-nodal name server 
(MNS).

The server is managed by the system administrator from a UNIX access 
window. Customer database servers can be configured to: 

• Automatically restart using the MDM Server Manager (SVM).

• Be LAN-wide accessible using the LAN Service Selector or the 
Multi-nodal Name Service (MNS) or both.

The Customer Data Server program is started as follows:

/opt/MagellanNMS/bin/cdbserver database_name   
      [-create] [-h] &S

Where:

database_name

is the database name that the server is to manage.

-create
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creates a new database (optional).

-h

is Help. It prints command usage information.

&

places the server in background mode.

Note: When issuing a UNIX command in the background mode (using 
the & symbol), you must press Return twice to display the UNIX prompt 
again.

Creating a new database
A database cannot be populated until it has been created and managed by a 
customer data server. To create a new database and to provide access to it, 
start the Customer Data Server with the create option specified. The server 
starts, creates the database, and then waits for clients. If the specified database 
already exists, an error is displayed. This process must be done once for each 
new database.

Examples
The following example creates an empty database called Cust_Data in the 
current directory.

/opt/MagellanNMS/bin/cdbserver Cust_Data -create &

The response is:

cdbserver: Database ‘Cust_Data’ successfully created.
cdbserver: Database ‘Cust_Data’ successfully accessed.

This database is recognized by the cdbserver clients as the file Cust_Data.

If the database already exists, the following is displayed:

cdbserver: Error - database ‘Cust_Data’ already 
      exists.

The following example creates an empty database called Customer_Data in a 
directory called /home/databases.

/opt/MagellanNMS/bin/cdbserver /home/databases/
      Customer_Data -create &
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This database is recognized by the cdbserver clients as the file 
Customer_Data.

Database information
The customer database is stored on disk with the name specified in the -create 
option with the .db extension.

In order to minimize the time required to access records in the database, the 
database is stored as a sparse file. This means that there can be places in the 
file that contain no information and make the file appear larger than it actually 
is. This occurs if you use the ls -l command to check the size of the file. 
Therefore, to determine the actual size of the file, use the du -s command. 
This returns the correct size of the database in kilobytes.

For example, to display the size of my_database type:

du -s my_database.db

The response is:

36 my_database.db

This means the file is 36 kilobytes or approximately 36846 (36*1024) bytes.

Note: The size indicated by ls -l and du -s commands generally differs 
more for larger databases.

The database generally does not shrink in size, even after records have been 
deleted. As a result, it is necessary to recreate the database in order to reclaim 
disk space and to increase efficiency. This is done by using the cdbextract 
command. Refer to “Compress the database” (page 131) for more 
information.

The database cannot be copied or archived (for example, using cp or tar) like 
a regular file. In order to copy or archive the database, it must have its 
contents extracted into a file using cdbextract. The extracted file can then be 
copied or archived.

Accessing an existing customer database
To provide access to an existing database that does not currently have a 
customer data server, run a cdbserver process for the database with no options 
specified. This is the usual method for starting a cdbserver process. 
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The cdbserver process is started as follows:

/opt/MagellanNMS/bin/cdbserver database_name &

Example
The following example provides access to an existing database called 
Feb_01_CustData in directory /usr/db.

/opt/MagellanNMS/bin/cdbserver /usr/db/
      Feb_01_CustData &

The response is:

cdbserver: Database ‘/usr/db/Feb_01_CustData’ 
successfully accessed.

Combining external data into the customer database
Customer data can be added or merged from external databases using 
Customer Database Merge. This program takes a Preside Multiservice Data 
Manager (MDM) database name and customer data file as input and merges 
the external data into the database. See the figure “Customer data from 
external sources” (page 127).

Note: Alternatively, you can programmatically populate and query a 
database using the Embedded Programming Interface as described in 
241-6001-211 Preside MDM Embedded Programming Interface 
Reference Guide
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Figure 8
Customer data from external sources

Enter the cdbmerge program as follows: 

/opt/MagellanNMS/bin/cdbmerge database_name 
      merge_file [-replace] [-setsource] [-h]

Where:

database_name

is the name of the customer database. The name must be 1 to 32 characters 
long.

merge_file

is the name of a file containing external customer data to be merged.

-replace
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replaces a record if the record being merged already exists in the database. If 
this option is not specified, then an existing database record will not be 
replaced (optional).

-setsource

sets the source field of all records in the merge_file to MDM.

-h

is Help. It prints command usage information.

Example
The following example adds data from customer data file ext_customerdata 
to database new_database.

/opt/MagellanNMS/bin/cdbmerge new_database 
      ext_customerdata

The response is:

NOTE: cdbmerge - Starting merge of file 
‘ext_customerdata’ into database ‘new_database’.

Records merged ...
100 200 300 400 500 600 700 800 900 1000

NOTE: cdbmerge -Merge completed.
1322 records added to database.
0 errors.

Example
The following example merges customer data file ext_customerdata into 
existing database existing_database and replaces any duplicate records with 
records from the merge file. The -setsource option sets the source fields of all 
records to MDM.

/opt/MagellanNMS/bin/cdbmerge existing_database
       ext_customerdata -replace -setsource

Updating the customer database
1 Create a new customer database.

2 Load any other external data into the database.

3 Extract all data from the old database and load it into the new database 
by specifying the -replace option.
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Extracting or deleting data from the database
Data records may be extracted, and optionally deleted from the Preside 
Multiservice Data Manager (MDM) database using the cdbextract program. 
This program searches the database for the requested records and writes them 
to a file or, by default, to standard output. The records are written out in the 
same format as is accepted by the cdbmerge program. The records are erased, 
after having been extracted, if the -delete option is specified.

Note: Alternatively, you can programmatically populate and query a 
database using the Embedded Programming Interface as described in 
241-6001-211 Preside MDM Embedded Programming Interface 
Reference Guide

Enter the cdbextract program as follows:

/opt/MagellanNMS/bin/cdbextract database_name
       [-file output_file] [-delete] 
       [-source (NMS|XXX)] [-comp (compid)] 
       [-related (related_compid)] [-h]

Where:

database_name

is the name of the customer database. The name must be 1 to 32 characters 
long.

-file output_file

is the name of the file in which the extracted records are to be stored. The 
default is standard out (optional). If the output is not required, specify 
/dev/null as the output_file.

-delete

erases the records after the records have been extracted. The default is do not 
delete (optional).

-source

is the source type of the records to be extracted, to a maximum of three 
characters. As a default, all records are extracted (optional).

-comp
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is the component ID to be searched for. Only records with a component_name 
field matching the specified component ID are written to the file specified by 
the -file option. The specified component ID must be an exact match to the 
packet module name without any trailing blanks or extra spaces.

-related

is the related component ID to be searched for. Only records with a 
component_name field matching the specified related component ID are 
written to the file specified by the -file option. The specified related 
component ID must be an exact match to the packet module name without any 
trailing blanks or extra spaces.

-h

is Help. It prints command usage information.

Example
The following example extracts all the records from the database and places 
them in a file called all_records.

/opt/MagellanNMS/bin/cdbextract new_database -file 
      all_records

Example
The following example extracts all records belonging to component names 
starting with PM R55. These records are placed in a file called R55.comp.

/opt/MagellanNMS/bin/cdbextract new_database -file 
      R55.comp -comp “PM R55”

Example
The following example extracts all records with related components that 
belong to PM R55. These records are placed in a file called R55.asso.

/opt/MagellanNMS/bin/cdbextract new_database -file 
      R55.comp -associate “PM R55”

Note: To extract all records belonging to packet module PM R55, 
combine Examples 4 and 5. You can also run cdbmerge on files 
R55.comp and R55.asso with the options -replace and -setsource, which 
will change the source fields in PM R55 to MDM.
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Backup customer database
If you want to archive or duplicate the current customer data, extract all the 
customer data into a file and store the file on tape or disk.

Updating data from a particular source
If data has been merged (using cdbmerge) into the database from a particular 
source and you want to update that data from the source again to keep the two 
files synchronized, perform the following:

• If a backup does not already exist, backup the database by extracting all 
the data and placing it in a file.

• From the existing database, extract and delete all the data from a 
specified source and place it in a file.

• Merge the new data into the existing database.

Example
In the following example, data in the cust_data database with a source type of 
ext is deleted and placed in a file called old_ext_records. Then the new source 
data in the new_ext_records file is merged into the cust_data database.

cdbextract cust_data -source ext -delete -file
    old_ext_records

cdbmerge cust_data new_ext_records

Compress the database
If many merge or delete operations have been done to the database, it is 
possible to reclaim disk space and increase efficiency by recreating the 
database. This is done by extracting all the data, deleting the database, and 
then recreating and merging the extracted data.

 External customer data format
External customer data can be added to the Preside Multiservice Data 
Manager (MDM) database provided it is in the proper format. All external 
customer data is case sensitive and any multiple blanks between characters or 
at the end of a line are removed. The table “External data format” (page 132) 
describes the external data format required by the cdbmerge program.
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Table 9 
External data format

Field name Size 
(chars)

Description

Source 3 The source of this record. Possible values are MDM or any three 
character customer-specified value. This field is used to identify the 
source of records when extracting or updating records in the 
database.

Semicolon 1 Field delimiter

Date 8 Date in YYYYMMDD format. This may be any date, but it is 
suggested that it be the activation date of the component or the last 
modified date.

Semicolon 1 Field delimiter

Component 65 The component name in the network model format. This will be the 
key for this record in the MDM database.
Examples:
DNA:  DNA X01234567931123
Port:  PM R34 PE 7 PI 7 PO 1
Module:  PM R34
NCS OA:  PM R34 OA DPNOA
NCS application:  PM R34 OA DPNOA APPL APPNAME

Semicolon 1 Field delimiter

Related 
component

46 (only used for DNAs) The component with which the DNA is related 
(for example, a Port or PE) The name is up to the port level only 
(that is, a DNA for an SNA LU has the component name of the LU 
up to the Port only).

Semicolon 1 Field delimiter

Data length 4 The number of characters of customer data in the Customer Data 
area.

Semicolon 1 Field delimiter

 (Sheet 1 of 2)
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Example
The figure “External data file format” (page 133) shows the proper format of 
the external data file. This file is suitable for merging with customer data. If 
the records are not in the proper format, an error message appears when you 
try to merge the file. 

Note: The top two lines of this example are not included in the data file, 
but have been added to show field positioning. The values in the 
component and related component fields are forced to upper case by the 
cdbmerge utility.

Figure 9
External data file format

Customer data up to 
1300

The customer data, which is ASCII text containing newlines (ASCII 
10), spaces (ASCII 32), and printable characters (ASCII 33-126). 
Characters other than these are not recognized by the Customer 
Data Tool and should not be included in the customer data. NULL 
characters (ASCII 0) cannot be included.

Newline character 1 A newline is located at the end of the record. It is not part of the 
customer data and is not included in the customer data length.

Table 9  (Continued)
External data format

Field name Size 
(chars)

Description

 (Sheet 2 of 2)

00000000011111111112222222222333333333344444444445555555555666666
66667777777777
12345678901234567890123456789012345678901234567890123456789012345
67890123456789
NMS;19930731;PM R34 PE 4 PI 4 PO 1                                            ;
                                              ;0069;X25
Customer: A&L Trust Co.
Contact: Fred Smith
Phone: 744-3434 x2344
NMS;19930731;DNA X404443444505431                                             ;
PM R34 PE 3 PI 2 PO 2                         ;0062;X25
Customer: ABC Plumbing
Contact: John Jones
Phone: 836-9876
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Deployment considerations
The customer database potentially requires a large amount of disk space on 
the Preside Multiservice Data Manager (MDM). The amount of disk space is 
proportional to the number of components, particularly DNAs and ports, for 
which customer data is to be stored. In general, it is suggested that one copy 
of customer data be stored on a workstation server and that it be shared across 
a LAN.

The Network Reporting System (NRS) requires that the customer database 
file be on a disk that is accessible by each workstation running reports that 
include customer data. NRS does not use the customer data server.

Keyboard shortcuts
The Customer Data Tool provides the following command shortcuts:

• Ctrl+E exits the Customer Data Tool.

• Ctrl+X cuts selected text.

• Ctrl+C copies selected text.

• Ctrl+V pastes selected text.

See also...

• “Mnemonics” (page 134)

Mnemonics
Some characters in menus and menu items have an underscore. These are 
mnemonics that you can use instead of using the mouse. 

You can use the following keys in combination with the mnemonics: 

• Meta key. For example, Meta-F X opens the File menu and exits 
Customer Data.

• F10 key. For example, F10 F X opens the File menu and exits Customer 
Data.

See also...

• “Keyboard shortcuts” (page 134)
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